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Preface
SIMPLIA MF-STEPCOUNTER is an application that measures individual program step information, analyzes interrelationships among
various development resources, and creates documents based on C, COBOL, Java, IDL, HTML, JSP, CSS, JavaScript, ASP, C#, Visual
Basic, VBScript, and JScript source files, include files, COBOL libraries, and text files.

 
New Features

Enhancements from V60L13 are shown below.

- Added "Continue measurement without displaying message" as common option.

 
To Read the Help

The latest version of Internet Explorer supported by each operating system is recommended as the web browser for referring to the user's
guide.

 
Registered Trademark Information

The registered trademarks and trademarks used in this user's guide are as follow.

- Microsoft, Windows, MS-DOS, MS, Visual C#, and Visual Basic are registered trademarks of Microsoft Corporation in the United States
and other countries.

- INFORMIX is a registered trademark of Informix Software, Inc. in the United States.

- Oracle and Java are registered trademarks of Oracle and/or its affiliates in the United States and other countries. Company names and
product names used in this document are registered trademarks or trademarks of those companies.

 
Abbreviations

The following abbreviations are used in this user's guide.

 
"Windows(R) 10 Home",
"Windows(R) 10 Pro",
"Windows(R) 10 Enterprise", or
"Windows(R) 10 Education"

-
>

"Windows 10"

"Windows(R) 8.1",
"Windows(R) 8.1 Pro", or
"Windows(R) 8.1 Enterprise"

-
>

"Windows 8.1"

"Windows(R) 7 Home Premium",
"Windows(R) 7 Professional",
"Windows(R) 7 Enterprise", or
"Windows(R) 7 Ultimate"

-
>

"Windows 7"

"Microsoft(R) Windows Server(R) 2016 Datacenter",
"Microsoft(R) Windows Server(R) 2016 Standard", or
"Microsoft(R) Windows Server(R) 2016 Essentials"

-
>

"Windows Server 2016”

"Microsoft(R) Windows Server(R) 2012 R2 Datacenter",
"Microsoft(R) Windows Server(R) 2012 R2 Standard",
"Microsoft(R) Windows Server(R) 2012 R2 Essentials", or
"Microsoft(R) Windows Server(R) 2012 R2 Foundation"

-
>

"Windows Server 2012 R2"

"Microsoft(R) Windows Server(R) 2012 Datacenter",
"Microsoft(R) Windows Server(R) 2012 Standard",
"Microsoft(R) Windows Server(R) 2012 Essentials", or
"Microsoft(R) Windows Server(R) 2012 Foundation"

-
>

"Windows Server 2012"

"Microsoft(R) Windows Server(R) 2008 R2 Datacenter",
"Microsoft(R) Windows Server(R) 2008 R2 Standard",
"Microsoft(R) Windows Server(R) 2008 R2 Enterprise", or
"Microsoft(R) Windows Server(R) 2008 R2 Foundation"

-
>

"Windows Server 2008 R2"
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"Windows 10",
"Windows 8.1",
"Windows 7",
"Windows Server 2016",
"Windows Server 2012 R2",
"Windows Server 2012", or
"Windows Server 2008 R2"

-
>

"Windows"

"Microsoft(R) Visual C#(R)" -
>

"C#"

"Microsoft(R) Visual Basic(R) Version 6.0" -
>

"Visual Basic 6.0" or "VB 6.0"

"Java(TM)" -
>

"Java"
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Chapter 1 Background and Purpose
In the maintenance and management phases during application development, if development quantity and work quantity are treated as
values, a program development step may be used as a criterion.

During manual measurement, problems such as the following may be encountered.

- The number of measurements becomes enormous if information of include files, libraries, and other things are included.

- The measurement quantity increases in proportion to development resources.

- The measurement methods and measurement criteria are inconsistent among projects.

MF-STEPCOUNTER automates the measurement of program source steps, include files, COPY phrase library files, and other files
performed manually in a traditional manner in order to reduce the time required for measurement operations and to improve reliability of
the measurement results. It can also maintain asset list information of the measurement target to establish measurement criteria and provide
consistency.

- 1 -



Chapter 2 Overview
MF-STEPCOUNTER has the following features.

- Step Measurement

This function is able to obtain the measurement results based on measurement criteria. The measurement results can be displayed on
screen and output to files by programming language, and also used as useful information for maintenance tasks.

- Variation Measurement

This function is able to measure variation steps by comparing new and old sources. Variation steps can be measured by valid lines and
by comment lines, according to the language category, and therefore, it is useful for grasping valid variations even though it is hard to
do through simple file comparison.

- Java Software Metrics Measurement

This function measures items from Java sources and class files as indications of class and method quality management and evaluation.
Measurement is available by class unit and by method unit, and the measurement results are output for each specified measurement unit.

For details on Java Software Metrics Measurement, refer to the user's guide for the "Java Software Metrics Measurement function."
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Chapter 3 Installation Procedure
This chapter explains the installation procedure for MF-STEPCOUNTER.

3.1 Installation and Uninstallation
For details on the installation and uninstallation of MF-STEPCOUNTER, refer to the Software Release Guide provided with the product.

First-time MF-STEPCOUNTER users should refer to Sample Usage. The section explains a rough outline of operation.
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Chapter 4 Function Description
This chapter explains the various functions of MF-STEPCOUNTER.

4.1 Step Measurement Criteria
This section explains the criteria for step measurement.

4.1.1 Auto-detection Measurement Criteria
The target file is measured according to the measurement criteria of each language category. The language category is judged by the
extension of the measured file.

For file extensions that are measured and the corresponding measurement criteria, refer to the following table.

The extension column shows the extensions set during installation. Use the [Common - Extension] option to make changes.

 
Extension Type Measurement Criteria

(*.CBL), (*.COB), (*.COBOL), (*.SCOB), (*.PCO) COBOL 4.1.2 COBOL Measurement Criteria

(*.C), (*.CPP), (*.H), (*.RC) C/C++ 4.1.3 C/C++ Measurement Criteria

(*.JAVA)
Java Class
Java Interface 4.1.4 Java Measurement Criteria

(*.SQLJ) SQLJ

(*.IDL) IDL 4.1.6 IDL Measurement Criteria

(*.HTML), (*.HTM) HTML

4.1.7 HTML/JSP/JS/CSS Measurement
Criteria

(*.JSP), (*.JSPF), (*.TAG), (*.TAGX), (*.TAGF) JSP

(*.JS) JavaScript

(*.CSS) StyleSheet

(*.ASP), (*.ASAX), (*.ASCX), (*.ASPX) ASP.NET
4.1.8 .NET (ASP/C#/VB)/
HTML/JS/CSS Measurement Criteria

(*.CS) C#

(*.VB), (*.VBS) VB.NET

(*.FRM), (*.BAS), (*.CLS), (*.CTL), (*.PAG), (*.DSR) VB 6.0
4.1.9 Visual Basic 6.0 Measurement
Criteria

(*.TXT) TEXT 4.1.10 TEXT Measurement Criteria

4.1.2 COBOL Measurement Criteria
COBOL measurement criteria are as follow.

 
Note Judgment

- The 7th column contains one of the following values.

- "*" General note line

- "/" Page break specification

- "D" Debug line

- The first line is one of the following values.

- "@OPTIONS" Translation option specification

- "PROCESS" Translation option specification
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- "CBL" Translation option specification

- Embedded SQL statements.

- Blank lines. (If the [Measure blank lines as comments] option is selected.)

- In-line notes from "*>" to the end of the line.

Remarks

- The COBOL free source format is not supported.

- The program structures of .NET programming and object-oriented programming are not supported.

- In COBOL, blank lines are lines containing only line numbers or lines whose 7th and following digits contain only one-byte or two-
byte blank spaces and tabs.

 
Library Judgment

- Library (COPY) judgment is performed as follows.

- COPY ......

- Library (INCLUDE) judgment is performed as follows.

- INCLUDE ......

Remarks

- If the file name including the extension is specified with the word COPY or INCLUDE, files not having the extensions specified in New
Measurement are also measured.

- One or more blank spaces or tabs must be inserted between the word COPY or INCLUDE and the library file name. In addition, if
inserted, a line break will constitute a target file limitation.

- Embedded SQL include files (EXEC SQL INCLUDE) and embedded SQL libraries are not regarded as the targets of embedded
members.

- The "SUBSCHEMA Name" for AIM DB use is not measured as a library.

 
Declaration Division and Execution Division Judgment

- The criterion for declaration division judgment is shown below.

- From "IDENTIFICATION DIVISION", including the head of the source file, to the line preceding "PROCEDURE DIVISION."

- The criterion for execution division judgment is shown below.

- From "PROCEDURE DIVISION" to the end of the source file.

Remarks

- The start of the identification division (word IDENTIFICATION DIVISION) and the start of the procedure division (word
PROCEDURE DIVISION) must be described in the source file of the target COBOL program. If either of or both of these are not
described or are described in a COPY phrase library file, STEPCOUNTER cannot perform measurement properly.

- If the "Measure by program ID" option of [Step Measurement - Measure] is selected, the range from "IDENTIFICATION DIVISION"
to the line preceding the next "IDENTIFICATION DIVISION" is regarded as one program, and the main program and subprograms
are measured.
If programs have been nested, the end program statement of the outermost program increases steps as the last detected program
measurement result.
The file name and the program IDs are displayed in the output measurement results.

- If the "Measure by program ID" option of [Step Measurement - Measure] is not selected, only the main program is measured. However,
the range measured as the main program is the set of lines before the "IDENTIFICATION DIVISION" of a subprogram. Only the file
name is displayed in the output measurement results.

 
Embedded SQL Judgment (COBOL)

ANSI standard-compliant SQL syntax is shown below. (ORACLE, RDB II, Informix, etc.)
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1. Declaration Section

EXEC SQL BEGIN DECLARE SECTION END-EXEC                  +

01 ~ +                                                   |

01 ~ |- Host variable, indicator variable declaration     |- Declarations are also counted as 

embedded SQL.

01 ~ +                                                    | (5 steps)

EXEC SQL END DECLARE SECTION END-EXEC                     +

2. Others

EXEC SQL +

 ~        |- The range from "EXEC SQL" to "END-EXEC" is counted as embedded SQL.

END-EXEC + (3 steps)

- If a "hyphen (-)" appears twice continuously in embedded SQL, the relevant line to the end of the line is regarded as a note.

- One or more blank spaces or tabs must be inserted between the word EXEC and the word SQL. In addition, if inserted, a line break
will constitute a target file limitation.

 
Measurement Judgment Examples

Judgment        Source Program Description (sample.cob)

                .....*....1....*....2....*....3....*....4....*....5....*....6....

Comment         000100 @OPTIONS QUOTE

Comment         000200* * * * * * * * * * * * * * * * * * * * * * * * * * * * *

Comment         000300* Step Measurement  COBOL Source Measurement Examples

Comment         000400* ALL Rights Reserved Copyright FUJITSU LIMITED 2004

Comment         000500* * * * * * * * * * * * * * * * * * * * * * * * * * * * *

                000600 IDENTIFICATION DIVISION.

                000700 PROGRAM-ID. TEST01.

                000800 AUTHOR. FUJITSU LTD.

Comment         000900*

                001000 ENVIRONMENT DIVISION.

                001100 CONFIGURATION SECTION.

                001200 SOURCE-COMPUTER. FACOM.

                001300 OBJECT-COMPUTER. FACOM.

Comment         001400D WITH DEBUGGING MODE.

                001500 SPECIAL-NAMES.

                001600 SUBSCHEMA-NAME. "AAAAA".

                001700 INPUT-OUTPUT SECTION.

                001800 FILE-CONTROL.

Comment         001900* Displayed file

                002000 SELECT DSP-FILE ASSIGN TO DSPDD.

Comment         002100/

                002200 DATA DIVISION.

Comment         002300* Based-storage section

                002400 BASED-STORAGE SECTION.

Comment         002500* File section

                002600 FILE SECTION.

                002700 FD DSP-FILE.

                002800 INCLUDE DSP01.

Comment         002900* Working-storage section

                003000 WORKING-STORAGE SECTION.

Comment         003100* RDB host variable

SQL Statement   003200 EXEC SQL BEGIN DECLARE SECTION END-EXEC.

SQL Statement   003300 01 SQL-USERID PIC X(20).

SQL Statement   003400 01 SQL-PASSWD PIC X(20).

SQL Statement   003500 EXEC SQL END DECLARE SECTION END-EXEC.

Comment         003600* Common area

                003700 COPY COMMWK1 REPLACING ==X== BY ==C==.

Comment         003800* Constant section

                003900 COPY CONST01 OF COMMDD.

                004000 LINKAGE SECTION.
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                004100 REPORT SECTION.

                004200 SCREEN SECTION.

Comment         004300/

                004400 PROCEDURE DIVISION.

                004500 MAIN01 SECTION.

SQL Statement   004600 EXEC SQL

SQL Statement   004700 CONNECT :SQL-USERID

SQL Statement   004800 IDENTIFIED BY :SQL-PASSWD

Comment         004900 -- "PASS-WORD"

SQL Statement   005000 END-EXEC.

Comment         005100

                005200 MOVE A TO B. *> A is ~

Comment         005300 *> B is ~

Comment         005400* The next MOVE command is counted as 3 lines.

                005500 MOVE

                005600 B TO

                005700 C.

Comment         005800

                005900 STOP RUN.

Comment         006000/

                Measurement would to be the TEST011 below if "Measure by program ID" is selected, and 

it would be exempt from measurement if not selected.

                006100 IDENTIFICATION DIVISION.

                006200 PROGRAM-ID. TEST011.

Comment         006300*

                006400 END PROGRAM TEST011.

                006500 END PROGRAM TEST01.

                006600

                [EOF]

4.1.3 C/C++ Measurement Criteria
C/C++ measurement criteria are as follow. These measurement criteria are also applied to resource files, excluding the RDB section.

 
Note Judgment

- The steps enclosed by a "/*" and "*/" pair. (C, C++)

- From "//" to the end of the line. (C++)

- Embedded SQL statements. (C)

- Blank lines. (If the [Measure blank lines as comments] option is selected.)

- Lines with only "{" and "}" are described. (If the [Measure lines with only "{" & "}" as comments] option is selected. However, lines
with " { }" are regarded as valid lines.)

 
Include Judgment

- #include <.....>

- #include "....."

- #include .....

- rcinclude .....

Remarks

- #include must be lowercase.

- Embedded SQL include files (EXEC SQL INCLUDE) are not regarded as the targets of embedded members.

- Embedded SQL include statements (such as #include) are not regarded as the targets of embedded members.

 

- 7 -



Embedded SQL Judgment (C)

ANSI standard-compliant SQL syntax (such as ORACLE, RDB II, and Informix) or Informix ESQL/C-compliant syntax.

- From "EXEC SQL" to "; (semicolon)".

- Lines in the range of "EXEC SQL BEGIN ~" to "EXEC SQL END ~".

- From "$" to "; (semicolon)".

- If a "hyphen (-)" appears twice continuously in embedded SQL, the relevant line to the end of the line is regarded as a note.

Remarks

- "EXEC SQL" must be uppercase.

- One or more blank spaces or tabs must be inserted between the word EXEC and the word SQL. In addition, if inserted, a line break will
constitute a target file limitation.

- C/C++ variables whose names include "$" are regarded as SQL lines. To prevent measurement of SQL, if necessary, change the [Step
Measurement - Measure] option setting.

 
Measurement Judgment Examples

Judgment        Source Program Description (sample.c)

Comment         /* Step Measurement  C Source Measurement Examples */

Comment         /* ALL Rights Reserved Copyright FUJITSU LIMITED 2004 */

                #include <stdio.h>

                #include "pp.h"

Comment    

SQL Statement       EXEC SQL BEGIN DECLARE SECTION END-EXEC.

SQL Statement           VARCHAR user[20];

Comment                 /* VARCHAR user[20]; */

SQL Statement           long ten;

SQL Statement           char stname[14];

SQL Statement           char kouza _code[6];

SQL Statement           char kouza _name[24];

SQL Statement       EXEC SQL END DECLARE SECTION END-EXEC.

SQL Statement       EXEC SQL INCLUDE SQLCA;

Comment 

                    main()

                    {

                        long I,j,max,ten_sv;

Comment

                        strcpy(user.arr,"SCOTT"); /*String copy*/

                        user.len=strlen(user.arr);

                        strcpy(pass.arr,"TIGER");

                        pass.len=strlen(pass.arr);

SQL Statement           EXEC SQL CONNECT : user IDENTIFIED BY :pass;         /*COMMENT*/

SQL Statement           EXEC SQL WHENEVER NOT FOUND GOTO NOT_FOUNTED;

                        while(1) {

SQL Statement               EXEC SQL DECLARE TEN_CUR CURSOR FOR

SQL Statement                   SELECT SEISEKI.TEN, STUDENT.STNAME

SQL Statement                   FROM SEISEKI, STUDENT, KOZA

SQL Statement                   WHERE SEISEKI.STNO=STUDENT.STNO         --COMMENT

Comment                                                                        --COMMENT

SQL Statement                       AND SEISEKI.KOUZA_CODE=:kouza _code

SQL Statement                       AND SEISEKI.KOUZA_code=:kouza _code

SQL Statement                       ORDER BY SEISEKI.KOUZA_CODE=:kouza _code;

Comment                         /* printf("\nEnter the course code (ending with e)");*/

                                scanf("%s",kouza_code);

Comment                     /** .....

Comment                     *** .....

                            */ if(kouza_code[0]='e') exit(0);

                        }
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                    }

                    [EOF]

4.1.4 Java Measurement Criteria
Java measurement criteria are as follow.

 
Note Judgment

- The steps enclosed by a "/*" and "*/" pair.

- From "//" to the end of the line.

- The steps enclosed by a "/**" and "*/" pair. (Javadoc comment)

- Embedded SQL statements.

- Blank lines. (If the [Measure blank lines as comments] option is selected.)

- Lines with only "{" and "}" are described. (If the [Measure lines with only "{" & "}" as comments] option is selected. However, lines
with " { }" are regarded as valid lines.)

 
Embedded SQL Judgment (Java)

- From "#sql" to "; (semicolon)".

#sql *** *** ;

#sql *** = { *** } ;

#sql { *** } ;

To the first "; (semicolon)" if "{} (braces)" are absent.

To the first "};" if "{} (braces)" are present.

No "{ }" nesting.

- If a "hyphen (-)" appears twice continuously in embedded SQL, the relevant line to the end of the line is regarded as a note.

 
Measurement Judgment Examples

Judgment        Source Program Description (sample.java)

Comment         /*

Comment         ** Step Measurement  SQLJ Source Measurement Examples

Comment         ** ALL Rights Reserved Copyright FUJITSU LIMITED 2004

Comment         /*

                import java.sql.*;

                import sqlj.runtime.ref.DefaultContext;   //sqlj runtime class import

Comment         //sqlj runtime class import

                import oracle.sqlj.runtime.Oracle;

Comment     

SQL Statement   #sql iterator Cursor1(String empno, String firstnme);

SQL Statement   #sql iterator

SQL Statement       Cursor2(String);

Comment     

                public class sampleClass {

SQL Statement       #sql cursor1 = { SELECT empno,firstnme from employee };

Comment     

SQL Statement       #sql { begin

SQL Statement           execute immediate

SQL Statement           `insert into ` ||:which_table ||

SQL Statement           `(ename, empno, sal) values( :1, :2, :3)'

Comment                     -- note:  PL/SQL rule is table | col name cannot be

Comment                     -- a bind argument in USING

Comment                     -- also, binds are by position except in dynamic PL/SQL blocks

SQL Statement           using :ename, :empno, :sal;
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SQL Statement           end;

SQL Statement       };

Comment    

javadoc             /**

javadoc                 Static method for update

javadoc             */

                    private static void staticUpdateReturning(int empno, double newSal)

                        throws SQLException {

                            System.out.println("static update-returning for empno " + empno);

                            String ename;

SQL Statement               #sql { begin

SQL Statement                   update emp set sal = :newSal

SQL Statement                   where empno = :empno

SQL Statement                   returning ename into :OUT ename; -- :OUT is for SQLJ bind

Comment                             -- :OUT is for SQLJ bind

SQL Statement                   end;

SQL Statement               };

                            System.out.println("Update the salary of employee " + ename);

                    }

Comment         

                }

                [EOF]

4.1.5 Auto-generated Java Source Measurement Criteria
Auto-generated Java source measurement criteria are as follow.

 
Note Judgment & Embedded SQL Judgment (Java)

- Based on Java Measurement Criteria.

 
Handwritten & Auto-generation Judgment

- Handwritten and auto-generation are judged based on the [Step Measurement - Auto-detection (Java)] option settings. The range from
the line following the start identifier to the line prior to the end identifier is measured as handwritten and the other sections are measured
as auto-generation.

- Automatic identifiers are searched for using a prefix search.

- The following identifiers are exempt from judgment, so caution is necessary.

- Start identifiers and end identifiers nested within a start identifier and end identifier pair

- The end identifier from an invalid start and end identifier combination

- An end identifier whose corresponding start identifier is absent

- The result of the measurement of source containing no pairs of automatic identifiers is measured entirely as an auto-generated source
(embedded steps).

Remarks

- When measurement results are output, auto-generated sections are output as step information.

- For identifiers pre-registered as standard, refer to 5.11.6 [Step Measurement - Auto-detection (Java)] Option Settings.

 
Measurement Judgment Examples

Judgment                    Source Program Description (Generation_sample.java)

Embedded/Comment            /*

Embedded/Comment            ** Step Measurement  SQLJ handwritten & auto-generation judgment examples

Embedded/Comment            ** ALL Rights Reserved Copyright FUJITSU LIMITED 2004

Embedded/Comment            */

Embedded/Valid              import java.sql.*;

Embedded/Valid              import sqlj.runtime.ref.DefaultContext;   //sqlj runtime class import
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Embedded/Comment            //sqlj runtime class import

Embedded/Valid              import oracle.sqlj.runtime.Oracle;

Embedded/Comment 

Embedded/SQL Statement      #sql iterator Cursor1(String empno, String firstnme);

Embedded/SQL Statement      #sql iterator

Embedded/SQL Statement          Cursor2(String);

Embedded/Comment 

Embedded/Valid              public class sampleClass {

Embedded/SQL Statement          #sql cursor1 = { SELECT empno,firstnme from employee };

Embedded/Comment 

Embedded/SQL Statement          #sql { begin

Embedded/SQL Statement              execute immediate

Embedded/SQL Statement              `insert into ` ||:which_table ||

Embedded/SQL Statement              `(ename, empno, sal) values( :1, :2, :3)'

Embedded/Comment                        -- note:  PL/SQL rule is table | col name cannot be

Embedded/Comment                        -- a bind argument in USING

Embedded/Comment                        -- also, binds are by position except in dynamic PL/SQL blocks

Embedded/SQL Statement               using :ename, :empno, :sal;

Embedded/SQL Statement               end;

Embedded/SQL Statement          };

Embedded/Comment                //>>ユーザ領域開始

Handwritten/javadoc             /**

Handwritten/javadoc             Static method for update

Handwritten/javadoc             */

Handwritten/Valid               private static void staticUpdateReturning(int empno, double newSal)

Handwritten/Valid                   throws SQLException {

Handwritten/Valid                       System.out.println("static update-returning for empno " + empno);

Handwritten/Valid                       String ename;

Handwritten/SQL Statement               #sql { begin

Handwritten/SQL Statement                   update emp set sal = :newSal

Handwritten/SQL Statement                   where empno = :empno

Handwritten/SQL Statement                   returning ename into :OUT ename; -- :OUT is for SQLJ bind

Handwritten/Comment                             -- :OUT is for SQLJ bind

Handwritten/SQL Statement                   end;

Handwritten/SQL Statement               };

Handwritten/Valid                       System.out.println("Update the salary of employee " + ename);

Handwritten/Valid               }

Embedded/Comment                //ユーザ領域終了>>

Embedded/Valid              }

                            [EOF]

4.1.6 IDL Measurement Criteria
IDL measurement criteria are as follow.

 
Note Judgment

- The steps enclosed by a "/*" and "*/" pair.

- From "//" to the end of the line.

- Blank lines. (If the [Measure blank lines as comments] option is selected.)

- Lines with only "{" and "}" are described. (If the [Measure lines with only "{" & "}" as comments] option is selected. However, lines
with " { }" are regarded as valid lines.)

 
Measurement Judgment Examples

Judgment   Source Program Description (sample.idl)

Comment    /*

Comment    ** Step Measurement  IDL Source Measurement Examples

Comment    ** ALL Rights Reserved Copyright FUJITSU LIMITED 2004

Comment    */
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           module Module1 {

Comment  

Comment        // Java interface declaration

               interface Func1 {

                   typedef long otype;

                   exception FuncException { //Exception declaration

Comment                //Exception declaration

                       string reason;

                   };

Comment 

                   otype Open(in string name)

                       raises(FuncException);

                   readonly attribute long data;

                   typedef Object FuncObject;

               }

           }

           [EOF]

4.1.7 HTML/JSP/JS/CSS Measurement Criteria
HTML/JSP/JS/CSS measurement criteria are as follow.

 
Note Judgment

- The steps enclosed by a "<!--" and "-->" pair in an HTML or JSP file. (*1, *2)

- The steps enclosed by a "<comment>" and "</comment>" pair in an HTML or JSP file. (*2)

- The steps enclosed by a "<%--" and "--%>" pair in a JSP file. (*2)

- The steps with "//" at the beginning in the range enclosed by a "<%" and "%>" pair in a JSP file.

- The steps enclosed by a "/*" and "*/" pair in the range enclosed by a "<%" and "%>" pair in a JSP file.

- The steps within the <SCRIPT> tag in an HTML or JSP file. (*3)

- The steps within the <STYLE> tag in an HTML or JSP file.

- The steps with "//" at the beginning in a JS or CSS file.

- The steps enclosed by a "/*" and "*/" pair in a JS or CSS file.

- Blank lines. (If the [Measure blank lines as comments] option is selected.)

- Lines with only "{" and "}" are described. (If the [Measure lines with only "{" & "}" as comments] option is selected. However, lines
with " { }" are regarded as valid lines.)

*1: If JavaScript or VBScript is specified as the "language" or "type" attribute value in the <SCRIPT> tag, statements enclosed by a "<!--"
and "-->" pair are measured as comments in each script/language.

If a script other than the above is specified, a measurement error will occur and the range of <SCRIPT> to </SCRIPT> will be measured
as a comment line.

*2: The comment notation within the <XMP> tag and the comment notation after the <PLAINTEXT> tag are exempt and are measured as
valid lines.

*3: If a "language" and "type" attribute value is omitted in the <SCRIPT> tag, the statement within the <SCRIPT> tag is measured as a
JavaScript comment.

Remarks

- For accurate measurement, a <SCRIPT> tag declaring the "language" or "type" attribute must be described in one line. If a line break
is inserted in the middle of the <SCRIPT> tag, the script attribute of the <SCRIPT> tag specified previously is used in measurement.
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Measurement Judgment Examples

Judgment   Source Program Description (sample.html)

Valid      <HTML>

Valid      <HEAD>

Comment    <!-- Step Measurement  HTML Source Measurement Examples -->

Comment    <!-- ALL Rights Reserved Copyright FUJITSU LIMITED 2004 -->

Comment

Valid      </HEAD>

Valid      <BODY>

Comment      <COMMENT>Test asset</COMMENT>

Valid        <SCRIPT LANGUAGE="JavaScript">

Valid        <!--

Comment      //test01 function

Valid        function test01(){

Comment      /*Return directly*/

Valid        return true;

Valid        }

Valid        -->

Valid        </SCRIPT>

Valid        <SCRIPT LANGUAGE="JavaScript">

Valid        <!--

Comment      //test02 function

Valid        function test02(){

Comment      /*Return directly*/

Valid        return true;

Valid        }

Valid        -->

Valid        </SCRIPT>

Valid        <STYLE TYPE="text/css">

Valid        <!--

Comment      /*Style*/

Valid        name {background-color:#ffcccc}

Valid        -->

Valid        </STYLE>

Valid      </BODY>

Valid      </HTML>

           [EOF]

4.1.8 .NET (ASP/C#/VB)/HTML/JS/CSS Measurement Criteria
ASP.NET, C#, and VB.NET resources and HTML, JS, and CSS can be included in measurement.

(Hereinafter, this manual abbreviates ASP/ASP.NET as ASP and Visual Basic/Visual Basic.NET as VB.)

.NET (ASP/C#/VB)/HTML/JS/CSS measurement criteria are as follow.

 
Note Judgment

- The steps enclosed by a "<!--" and "-->" pair in an ASP or HTML file. (*1, *2)

- The steps enclosed by a "<comment>" and "</comment>" pair in an ASP or HTML file. (*2)

- The steps enclosed by a "<%--" and "--%>" pair in an ASP file. (*2)

- The steps enclosed by a "<%" and "%>" pair in an ASP file. (*3)

- The steps within the <SCRIPT> tag in an ASP or HTML file. (*4)

- The steps within the <STYLE> tag in an ASP or HTML file.

- The steps with "//" at the beginning in a C#, JS, or CSS file.

- The steps enclosed by a "/*" and "*/" pair in a C#, JS, or CSS file.

- The steps with "Rem" at the beginning in a VB or VBScript file.
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- The steps with "' (apostrophe)" at the beginning in a VB or VBScript file.

- Blank lines. (If the [Measure blank lines as comments] option is selected.)

- Lines with only "{" and "}" are described. (If the [Measure lines with only "{" & "}" as comments] option is selected. However, lines
with " { }" are regarded as valid lines.)

*1: If C#, VB, JavaScript, VBScript, or JScript is specified as the "language" or "type" attribute value in the <SCRIPT> tag, statements
enclosed by a "<!--" and "-->" pair are measured as comments in each script/language.
If a script other than the above is specified, a measurement error will occur and the range of <SCRIPT> to </SCRIPT> will be measured
as a comment line.

*2: The comment notation within the <SCRIPT> tag, the <STYLE> tag, the <XMP> tag, a "<%@" and " %>" pair, and a "<%" and
"%>" pair and the comment notation after the <PLAINTEXT> tag are exempt and are measured as valid lines.

*3: If C#, VB, JavaScript, VBScript, or JScript is specified by the @language directive, statements enclosed by a "<%" and "%>" pair
are measured as comments in each script/language.
If the @language directive is omitted, statements enclosed by a "<%" and "%>" pair are measured as VBScript comments.

*4: If a "language" and "type" attribute value is omitted in the <SCRIPT> tag, statements within the <SCRIPT> tag are measured
according to the script attribute specified by the @language directive.

Remarks

- For accurate measurement, a <SCRIPT> tag declaring the "language" or "type" attribute must be described in one line. If a line break
is inserted in the middle of the <SCRIPT> tag, one of the following script attributes is used in measurement.

- When it is an ASP file

Depending on the line break position of the <SCRIPT> tag, the script attribute specified by the @language directive or the script
attribute of the <SCRIPT> tag specified previously is used in measurement.

- When it is an HTML file

The script attribute of the <SCRIPT> tag specified previously is used in measurement.

- Script attributes that can be specified in the <SCRIPT> tag or the @language directive vary depending on the extension of the measured
asset.

 
Extension Target Script

*.asp JavaScript, VBScript, JScript

*.asax,*.ascx,*.aspx C#, VB, JavaScript, VBScript, JScript

*.htm, *.html JavaScript, VBScript, JScript

 
Measurement Judgment Examples

Judgment  Source Program Description (sample.aspx) 

Valid     <%@ Page ContentType="text/html" Language="VB" %> 

Comment   <%--  

Comment   * * * * * * * * * * * * * * * * * * * * * * * * * * * 

Comment    Step Measurement  ASP.NET Source Measurement Examples 

Comment    ALL Rights Reserved Copyright FUJITSU LIMITED 2004 

Comment   * * * * * * * * * * * * * * * * * * * * * * * * * * * 

Comment   --%>  

Comment  

Valid     <HTML> 

Valid         <HEAD> 
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Valid             <TITLE>ASP.NET Sample</TITLE> 

Comment           <%-- Sample source --%> 

Valid             <meta content="JavaScript" name="vs_defaultClientScript"> 

Comment   

Valid             <script runat="Server"> 

Valid             Sub Page_Load(sender As Object, e As EventArgs) 

Comment              'Page initialization 

Valid                 TextBox.text = "Text box" 

Valid                 Button01.Attributes.add("OnClick","alert('Button 1 was pressed.') ;") 

Valid             End Sub 

Valid             </script> 

Valid             <script language="JavaScript"> 

Valid             <!-- 

Comment               /* test01 function */ 

Valid                 function test01(){ 

Comment                   //Display a message 

Valid                     window.alert("Button 2 was pressed.") ; 

Valid                 } 

Valid             --> 

Valid             </script> 

Comment   

Valid         </HEAD> 

Valid         <body> 

Valid             <form runat="server"> 

Comment               <!-- Comment --> 

Valid                 <h1>Sample source</h1> 

Valid                 <P><asp:textbox id="TextBox" runat="server"></asp:textbox></P> 

Valid                 <asp:button id="Button01" runat="server" Text="Button 1"></asp:button><br> 

Valid                 <br> 

Valid                 <input type="button" OnClick="test01();" value="Button 2"> 

Valid             </form> 

Valid         </body> 

Valid     </HTML> 

          [EOF] 

  

Judgment  Source Program Description (sample.cs) 

Comment   /* Step Measurement  C# Source Measurement Examples */ 

Comment   /* ALL Rights Reserved Copyright FUJITSU LIMITED 2004 */ 

Valid     using System; 

Comment  

Valid     class HelloClass 

Valid     { 

Valid         static void Main()  

Valid         { 

Comment           // Display hello world. 

Valid             Console.WriteLine("Hello World!"); 

Valid         } 

Valid     } 

          [EOF] 

  

Judgment  Source Program Description (sample.vb) 

Comment   '* * * * * * * * * * * * * * * * * * * * * * * * * * 

Comment   ' Step Measurement  VisualBasic.NET Source Measurement Examples 

Comment   ' ALL Rights Reserved Copyright FUJITSU LIMITED 2004 

Comment   '* * * * * * * * * * * * * * * * * * * * * * * * * * 

Valid     Imports System 

Valid     Class Hellow 

Comment  

Valid         Shared Sub Main() 

Comment           Rem Display hello world. 

Valid             Console.WriteLine("Hello world!"); 

Valid         End Sub 

Comment  
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Valid     End Class 

          [EOF] 

  

Judgment  Source Program Description (sample.asp) 

Valid     <%@ LANGUAGE="VBScript" %> 

Valid     <%  

Comment   '**************************** 

Comment   ' Step Measurement  ASP Source Measurement Examples 

Comment   ' ALL Rights Reserved Copyright FUJITSU LIMITED 2004 

Comment   '**************************** 

Valid     %>  

Comment  

Valid     <HTML> 

Valid     <HEAD> 

Comment     <%-- Sample source --%> 

Valid       <META http-equiv="Content-Type" content="text/html; charset=Shift_JIS"> 

Valid       <META http-equiv="Content-Script-Type" content="text/javascript"> 

Valid       <META http-equiv="Content-Style-Type" content="text/css"> 

Valid       <META http-equiv="Pragma" content="no-cache"> 

Valid       <LINK rel="StyleSheet" href="sample.css"> 

Valid       <TITLE>ASP Sample</TITLE> 

Comment  

Valid     <SCRIPT LANGUAGE="JavaScript"> 

Valid     <!-- 

Comment     /* test01 function */ 

Valid       function test01(){ 

Comment       //Display a message 

Valid         window.alert("The button was pressed.") ; 

Valid         return true; 

Valid       } 

Valid     --> 

Valid     </SCRIPT> 

Valid     </HEAD> 

Comment  

Valid     <BODY> 

Valid     <% 

Comment     'Display a string 

Valid       Response.Write "Hello World!!" 

Valid     %> 

Valid       <DIV align="center"> 

Valid       <TABLE> 

Valid         <INPUT type="submit" onClick="return test01();" name="Move" value=" Test "> 

Valid       </TABLE> 

Valid       </DIV> 

Valid     </BODY> 

Valid     </HTML> 

          [EOF]

4.1.9 Visual Basic 6.0 Measurement Criteria
Visual Basic 6.0 measurement criteria are as follow.

 
Note Judgment

- The steps with "Rem" at the beginning.

- The steps with "' (apostrophe)" at the beginning.

- Blank lines. (If the [Measure blank lines as comments] option is selected.)
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Handwritten & Auto-generation Judgment

- Handwritten and auto-generation are judged based on the [Step Measurement - Auto-detection (VB6.0)] option settings. The range from
the start identifier line to the end identifier line is measured as auto-generation and the other sections are measured as handwritten. This
is the opposite to the auto-generated Java source measurement criterion, so caution is necessary.

- Automatic identifiers are searched for using a prefix search.

- The following identifiers are exempt from judgment, so caution is necessary.

- Start identifiers and end identifiers nested within a start identifier and end identifier pair

- The end identifier from an invalid start and end identifier combination

- An end identifier whose corresponding start identifier is absent

- The result of the measurement of source containing no pairs of automatic identifiers is measured entirely as a handwritten source
(handwritten steps).

Remarks

- When measurement results are output, auto-generated sections are output as step information.

- For identifiers pre-registered as standard, refer to 5.11.7 [Step Measurement - Auto-detection (VB 6.0)] Option Settings.

 
Measurement Judgment Examples

Judgment              Source Program Description (sample.frm)

Handwritten/Comment   '* * * * * * * * * * * * * * * * * * * * * * * * * *

Handwritten/Comment   ' Step Measurement  VisualBasic Source Measurement Examples

Handwritten/Comment   ' ALL Rights Reserved Copyright FUJITSU LIMITED 2004

Handwritten/Comment   '* * * * * * * * * * * * * * * * * * * * * * * * * *

Handwritten/Comment

Embedded/Valid        VERSION 5.00

Embedded/Comment 

Embedded/Valid        Begin VB.Form Form1 

Embedded/Valid           Caption         =   "Form1"

Embedded/Valid           ClientHeight    =   3195

Embedded/Valid           ClientLeft      =   60

Embedded/Valid           ClientTop       =   345

Embedded/Valid           ClientWidth     =   4680

Embedded/Valid           LinkTopic       =   "Form1"

Embedded/Valid           ScaleHeight     =   3195

Embedded/Valid           ScaleWidth      =   4680

Embedded/Valid           StartUpPosition =   3 'Windows default

Embedded/Valid        End

Embedded/Comment

Embedded/Valid        Attribute VB_Name = "Form1"

Embedded/Valid        Attribute VB_GlobalNameSpace = False

Embedded/Valid        Attribute VB_Creatable = False

Embedded/Valid        Attribute VB_PredeclaredId = True

Embedded/Valid        Attribute VB_Exposed = False

Handwritten/Comment 

Handwritten/Valid     Imports System

Handwritten/Valid     Class Hellow

Handwritten/Comment

Handwritten/Valid        Shared Sub Main()

Handwritten/Comment         Rem Display hello world.

Handwritten/Valid           Console.WriteLine("Hello world!");

Handwritten/Valid        End Sub

Handwritten/Comment 

Handwritten/Valid     End Class

                      [EOF]
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4.1.10 TEXT Measurement Criteria
TEXT measurement criteria are as follow.

 
Note Judgment

- Blank lines. (If the [Measure blank lines as comments] option is selected.)

 
Measurement Judgment Examples

Judgment  Source Program Description (sample.txt)

          /*

          ** Step Measurement  Text File Measurement Examples

          ** ALL Rights Reserved Copyright FUJITSU LIMITED 2014

          */

          text TEXTModule1 {

Comment  

              // Declaration

              text Func1 {

                  long type;

                  exception txtException { 

                      //Exception declaration

                      return -1;

                  };

Comment 

              }

          }

          [EOF]

4.2 Variation Measurement Criteria
Variation measurement criteria are as follow. Refer also to the advisory notes.

-> Advisory Notes

 
About Target Files/Folders

In file specification and folder specification, specify a pair of old and new files/folders.

- In the case of file specification, the old and new file names can be different.

- In the case of folder specification, files with the same names in the old and new folders are compared. If some old and new file names
are inconsistent, for example, in the case of non-corresponding subfolders, the variation steps of each file are only deletions or
insertions.

 
Valid Lines & Comment Lines

- Valid line and comment line judgment is in accordance with the measurement criteria of each language category.

- As the measurement method is different from that of Step Measurement, the results do not match with the valid/comment steps from
Step Measurement.

- Depending on the [Consider comment range] option setting, the measurement method varies (See "Comparison Options" below).

-> Step Measurement always performs measurement considering comment range.

- If a valid section and a comment section are present in one line, each valid section and comment section is measured as a variation.

-> Step Measurement measures this line as a valid step.

Using the variation measurement results, comment lines can be derived with the following formula.
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[Number of Comment Lines Equal to Step Measurement Results] = [Total Steps] - [Valid Steps when 

"Consider comment range" Is On]

- Note that the methods of measuring some lines such as blank lines and lines with only "}" may vary depending on the [Measure
Variation - Measure] Option Settings.

 
Insertion/Variation/Deletion Judgment

- The old and new files are compared in a manner that derives the maximum number of matching lines.

- Lines in the old file judged as mismatching are regarded as deleted lines, and lines in the new file judged as mismatching are regarded
as inserted lines.

- If mismatching lines include consecutive deletions/insertions, the section of mismatched text that has fewer consecutive lines of
deletion/insertion is regarded as "variation lines".

* Lines that are inconsistent between old and new files and that are valid lines in the old file and comment lines in the new file do not
meet the condition for variation. Refer to [Non-variation Judgment Examples].

- If valid lines are commented out, the comment out is regarded as valid line deletion and comment line insertion, but "variation lines"
are not counted.

[Judgment Examples]

 
Old Source New Source Judgment Result

a = 0; //Default value a = 1; //Default value Valid line variation

b = 0; //Default value b = 0; Comment line deletion

c = 0; // c = 0; Valid line deletion and comment line insertion

[Variation Line Judgment Examples 1]

 
Old Source New Source Judgment Result

//Variable definition //Variable definition Matching

int a; int X; "int a;" deletion and "int X;" insertion correspond -> Variation line

int b; int Y; "int b;" deletion and "int Y;" insertion correspond -> Variation line

int c; (No line) "int c;" deletion only -> Deleted line

//Initialization process //Initialization process Matching

[Variation Line Judgment Examples 2]

 
Old Source New Source Judgment Result

int a = 0; int a = 1; Valid line variation

(No line) int b = 2; Valid line insertion

//Variable
initialization

//Variable
initialization

Matching

int c = a++; int d = a + b; "int c = a++;" deletion and "int d = a + b;" insertion correspond -> Variation line

int d = a + 2; (No line) Valid line deletion

[Non-variation Judgment Examples]

 
Old Source New Source Judgment Result

a = 0;
//Variable
initialization

Valid line deletion and comment line insertion

a = 1; Valid line insertion
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Comparison Options

- During the comparison of old and new files, options such as whether to consider blank spaces between words and whether to distinguish
between uppercase and lowercase letters use the [Measure Variation - Measure] Option Settings.

- The [Consider comment range] option specifies whether to consider lines that are not regarded as comments, such as C/C++ and Java /
* ~ */ comments, but are included in the comment range, as comments.

[Differences in Judgment Depending on Options]

 
Example Not Considered Considered

/* Comment out the next process Comment line Comment line

a = a + 1; Valid line Comment line

*/ Comment line Comment line

Refer to the 24th to 30th lines in the following measurement judgment example.

 
Measurement Judgment Examples

This section provides Java source judgment examples based on the following variation measurement options.

- Valid lines and comment lines are measured

- Blank lines are measured

- Lines with only "{" & "}" are not measured as comments

[If the comment range is not considered]

 

Valid Comment
N
o.

Old File New File

1 public class CompSample { public class CompSample {

Insertion 2         int memory;         int memory; //Previous calculation results

3         /**         /**

Variatio
n

4         * @param args         * @version 1.0

Insertio
n

5 (No line)         * @param Calculate from arguments 1 and 2

    6         */         */

    7         public static void main(String[] args) {         public static void main(String[] args) {

  Variation 8                 //TODO Auto-generated method                 //Instance generation

    9                 CompSample cs                 CompSample cs

    
1
0

                = new CompSample();                 = new CompSample();

  Variation
1
1

                  //Execute

Variatio
n

  
1
2

                int a = 10;                 int a = Integer.parseInt(args[0]);

Variatio
n

  
1
3

                int b = 20;                 int b = Integer.parseInt(args[1]);

    
1
4

                System.out.println( cs.add(a, b) );                 System.out.println( cs.add(a, b) );

- 20 -



Valid Comment
N
o.

Old File New File

Deletion Insertion
1
5

                System.out.println( cs.sub(a, b) );                 //System.out.println( cs.sub(a, b) );

    
1
6

        }         }

    
1
7

    

    
1
8

        //Addition method         //Addition method

    
1
9

        public int add(int a, int b) {         public int add(int a, int b) {

Variatio
n

Insertion
2
0

                return a+b;                 memory = a + b; //Store addition results

Insertio
n

  
2
1

(No line)                 return memory;

    
2
2

        }         }

    
2
3

    

  Insertion
2
4

(No line) /*

    
2
5

        //Subtraction method         //Subtraction method

    
2
6

        public int sub(int a, int b) {         public int sub(int a, int b) {

  Insertion
2
7

                memory = a - b;                 memory = a - b; //Store subtraction results

    
2
8

                return memory;                 return memory;

    
2
9

        }         }

  Insertion
3
0

(No line) */

    
3
1

} }

* As for the 11th line, it is considered as a blank line has been modified to a "//Execute" comment (Blank lines are comment lines).

[Measurement Results]

 
Valid Comment

Insertio
n

Variatio
n

Deletio
n

Insertio
n

Variatio
n

Deletio
n

2 4 1 6 2 0

[If the comment range is considered]

The commented out 3rd to 6th lines and 24th to 30th lines are judged as follows.
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Valid Comment
N
o.

Old File New File

3         /**         /**

Variation 4         * @param args         * @version 1.0

Insertion 5 (No line)         * @param Calculate from arguments 1 and 2

6         */         */

... ... ... ... ...

  Insertion
2
4

(No line) /*

    
2
5

        //Subtraction method         //Subtraction method

Deletio
n

Insertion
2
6

        public int sub(int a, int b) {         public int sub(int a, int b) {

Deletio
n

Insertion
2
7

                memory = a - b;                 memory = a - b; //Store subtraction results

Deletio
n

Insertion
2
8

                return memory;                 return memory;

Deletio
n

Insertion
2
9

        }         }

Insertion
3
0

(No line) */

As the contents of the 26th to 29th lines in the new file are regarded as comments, valid line deletions and comment insertions are counted,
even if no modifications were made.

[Measurement Results]

 
Valid Comment

Insertio
n

Variatio
n

Deletio
n

Insertio
n

Variatio
n

Deletio
n

1 3 5 10 3 0
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Chapter 5 Operation Description
This chapter explains how to operate MF-STEPCOUNTER.

5.1 Starting and Stopping
This section explains how to start and stop MF-STEPCOUNTER.

 
How to Start

Start [SIMPLIA MF-STEPCOUNTER] from the Start menu.

 
How to Stop

To stop MF-STEPCOUNTER, select "File" on the menu bar and select [Exit SIMPLIA MF-STEPCOUNTER] from the pull-down menu.
When data has been changed, a confirmation message asking whether to save the changes is displayed.

5.2 New Measurement
The following three methods are available for asset measurement.

 
Measurement Method Description

Step Measurement Measures the scale of the asset dividing it into valid steps and comment steps.

Variation Measurement
Measures deleted/modified/inserted steps by comparing the current asset and the past
asset.

Java Software Metrics
Measurement

This function measures the complexity of classes and methods from Java source files and
class files.

For details on Java Software Metrics Measurement, refer to the user's guide for the "Java Software Metrics Measurement function".

 
To Measure Steps

1. To perform C/C++ or COBOL asset measurement, including include, copy phrase, and other embedded file steps, first go to the [Step
Measurement - Search Path] Option Settings and specify the include file, copy phrase file, and other measured file paths. In addition,
in the [Step Measurement - Measure] Option Settings, select [Measure embedded members]. However, if this is enabled, it will take
a very long time to complete measurement because program file and embedded file relationships are analyzed, and therefore, the
targets of measurement should be narrowed down. (*1)

2. Select the [New Measurement] command from the [File] menu.

3. In the New Measurement 1/2 Dialog Box, select [Steps] under [Measurement Type]. Select [Language Category], [Target Asset
Specification Method], and [Character Code], and click the [Next] button.

4. In the New Measurement 2/2 Dialog Box, specify the measurement target source file or the folder in which the source file is located.

5. Specify all measurement targets, and click the [Finish] button. After measurement, the measurement results are displayed on screen.

*1: To skip the analysis of program file and embedded file relationships and rapidly measure the steps of embedded files, without
performing the above step 1, select [File] under [Target Asset Specification Method] in step 3, set [Files of Type] to [All Files By Language
Identifier] when selecting source files in step 4, and perform measurement.

 
To Measure Variation

1. Select the [New Measurement] command from the [File] menu.

2. In the New Measurement 1/2 Dialog Box, select [Variations] under [Measurement Type]. Select [Language Category], [Target Asset
Specification Method], and [Character Code], and click the [Next] button.
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3. In the New Measurement 2/2 Dialog Box, specify the old and new measurement target source files or the folders in which the source
files are located.(*2)

4. Specify all measurement targets, and click the [Finish] button. After measurement, the measurement results are displayed on screen.

*2: Old and new files with different names can be compared if "File" is selected for the target resource specification method, but only files
with the same name are compared if "Folder" is selected. To include subfolders in the measurement, the subfolders must also have the same
name.

 

Depending on the selected language category, measurement is performed using one of the following languages, based on the file extension.
The type column shows the names displayed in the "Type" field in the Program step information (List view) dialog.

The extension column shows the extensions set during installation. Use the [Common - Extension] option to make changes.

If the same extension has been assigned to multiple types, the language type that comes higher in the following table (except for Auto-
detection) is considered to be the language used for measurement.

 
Language Category Type Extension

Auto-detection
Identifies the type automatically
based on the extension of the
target file.

The extensions that can be specified for each
language

COBOL COBOL
(*.CBL), (*.COB), (*.COBOL), (*.SCOB),
(*.PCO)

C/C++ C/C++
(*.C), (*.CPP), (*.H), (*.RC)
(*.H depends on the [Step Measurement -
Measure] Option Settings.)

Java
Auto-generated Java Source

Java Class
Java Interface

(*.JAVA)

SQLJ (*.SQLJ)

IDL IDL (*.IDL)

HTML/JSP/JS/CSS
(*3)

HTML (*.HTML), (*.HTM)

JSP
(*.JSP), (*.JSPF), (*.TAG), (*.TAGX),
(*.TAGF)

VB.NET (*.VB)

VBScript (*.VBS)

JavaScript (*.JS)

StyleSheet (*.CSS)

.NET (ASP/C#/VB)/
HTML/JS/CSS
(*3)

ASP.NET (*.ASP), (*.ASAX), (*.ASCX), (*.ASPX)

C# (*.CS)

VB.NET (*.VB)

VBScript (*.VBS)

HTML (*.HTML), (*.HTM)

JScript (*.JS)

StyleSheet (*.CSS)

Visual Basic 6.0 VB 6.0
(*.FRM), (*.BAS), (*.CLS), (*.CTL),
(*.PAG), (*.DSR)

TEXT TEXT (*.TXT)
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*3: "JS" is the abbreviation of "JavaScript" and "JScript".

"CSS" is the abbreviation of "Cascading Style Sheets".

5.3 Edit Assets List
Edit the specified asset list.

As shown below, edit an asset list, and measure all or only the changed.

1. Re-edit the asset list specified for new measurement.

2. Edit the asset list after the reading of a measurement results file.

3. Edit the asset list after measurement.

 
To Edit the Asset List

1. Select the [Edit Assets List] command from the [File] menu.

2. In the case of step measurement, set the necessary items in the Edit Assets List Dialog Box.

3. In the case of variation measurement, set the necessary items in the Edit Assets List Dialog Box that provides old and new file lists.

4. After specification is complete, click the [OK] button.

After this procedure, start measurement from [Measure All] or [Measure Changed] and have the measurement results displayed on screen.

If the OK button is clicked after editing assets, the measurement results that have been displayed on screen are discarded unconditionally,
even if they are unsaved.

The displayed dialog (file or folder) depends on the method selected for new measurement under [Target Resource Specification Method]
in the New Measurement 1/2 Dialog Box.

5.4 Reading Measurement Results Files
Read the measurement results file to be measured, displayed, and edited.

 
To Read a File

1. Select the [Read] command from the [File] menu.

2. In the [Read Measurement Results File] dialog box, select the measurement results file and click the [Open] button.

3. The measurement results saved in the measurement results file are displayed on screen.

5.5 Measurement Results File Saving Method (Save As)
Save a file resulting from new measurement, or save an existing measurement results file as a new file with a new name.

 
To Save a File

1. Select the [Save As] command from the [File] menu.

2. In the [Save Measurement Results File] dialog box, specify the measurement results file name and click the [Save] button.

3. A measurement results file with the specified name is created.

Related items

5.6 Measurement Results File Saving Method (Save)
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5.6 Measurement Results File Saving Method (Save)
Update and save the original measurement results file after remeasurement.

 
To Save a File

1. Select the [Save] command from the [File] menu.

2. The measurement results file is overwritten with new measurement results.

Related items

5.5 Measurement Results File Saving Method (Save As)

5.7 CSV File Creation (Selected Range)
Save only the selected range of the measurement results as a List View CSV File.

 
To Save a File

1. Select the measurement results to be output to a CSV file from the list view (multiple selections are possible).

2. Select the [Save Selected Range As CSV File] command from the [File] menu.

3. In the [Save As CSV File] dialog box, specify the CSV file name and click the [Save] button.

4. A CSV file with the specified name is created.

- When the measurement results are displayed in the list view and only total or average lines are selected, this command is disabled.

- When [Save Selected Range As CSV File] is executed, average and total values are derived only from the information output to a CSV
file.

Related items

5.8 CSV File Creation

5.8 CSV File Creation
Save the measurement results as a CSV file. Depending on the display method for measurement results, the saved format varies.

- 5.8.1 Form CSV File

- 5.8.2 List View CSV File

 
To Save a File

1. Select the [Save As CSV File] command from the [File] menu.

2. In the [Save As CSV File] dialog box, specify the name for the CSV file and click the [Save] button.

3. A CSV file with the specified name is created.

Related items

5.7 CSV File Creation (Selected Range)

5.8.1 Form CSV File
Although a measurement results file is normally saved in a dedicated format for STEPCOUNTER to read and write, it is possible to use
[Save As CSV File] to save it as a "CSV (Comma Separated Value)" file. However, STEPCOUNTER cannot reload saved CSV files. In
addition, only part of the content of the form image is output.

CSV File Output Format
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0,  "c:\test\", "PROG0001", 318,  11,   0,   0, 519,  27,   0,   0,   0

0,  "c:\test\", "PROG0002", 613,  24,   0,   0, 768,  33,   0,   0,   0

:

2,  "c:\test\",  "ZCOPY01",  86,   5,   0,   0,   0,   0,   0,   0,   0

2,  "c:\test\",  "ZCOPY02",  56,   8,   0,   0,   0,   0,   0,   0,   0

:

1,  "c:\test\",  "ZINC000",  46,   3,   0,   0,   0,   0,   0,   0,   0

1,  "c:\test\",  "ZINC001",  81,   3,   0,   0,   0,   0,   0,   0,   0

|   |            |           |      |    |    |    |    |    |    |    |

(1) (2)         (3)          (4)   (5)  (6)  (7)  (8)  (9)  (10) (11) (12)

 
No. Output Item Description

(1) File Type 0: C/C++ source file or COBOL source file

1: C/C++ include file or COBOL include file

2: COBOL copy library file

4: Resource include file

5: Java/SQLJ source file

6: IDL source file

7: HTML source file

8: JSP source file

9: JS source file

10: CSS source file

11: ASP.NET source file

12: C# source file

13: VB.NET source file

14: VBScript source file

15: Visual Basic 6.0 source file

16: Text file

(2) Folder Name Output if [Output file path] is specified as a form option; blank if not specified;
and enclosed in double quotes (")

(3) File Name The measured file name, enclosed in double quotes (")

(4) Declaration Division
Actual Steps

Number of actual steps in the COBOL declaration division
0 in the case of C/C++, Java/SQLJ, IDL, HTML, ASP, VB 6.0, or TEXT

(5) Declaration Division
Comment Steps

Number of comment steps in the COBOL declaration division
0 in the case of C/C++, Java/SQLJ, IDL, HTML, ASP, VB 6.0, or TEXT

(6) Declaration Division
Blank Steps

Number of blank steps in the COBOL declaration division
0 in the case of C/C++, Java/SQLJ, IDL, HTML, ASP, VB 6.0, or TEXT

(7) Declaration Division
SQL Steps

Number of embedded SQL steps in the COBOL declaration division
0 in the case of C/C++, Java/SQLJ, IDL, HTML, ASP, VB 6.0, or TEXT

(8) Execution Division
Actual Steps

Number of actual steps in the COBOL execution division
Number of actual steps in the case of C/C++, Java/SQLJ, IDL, HTML, ASP,
VB 6.0, or TEXT

(9) Execution Division
Comment Steps

Number of comment steps in the COBOL execution division
Number of comment steps (including Javadoc comments) in the case of C/C
++, Java/SQLJ, IDL, HTML, ASP, VB 6.0, or TEXT

(10) Execution Division
Blank Steps

Number of blank steps in the COBOL execution division
0 in the case of C/C++, Java/SQLJ, IDL, HTML, ASP, VB 6.0, or TEXT
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No. Output Item Description

(11) Execution Division
JavaDoc Steps

Number of Java/SQLJ Javadoc comment steps
0 in the case of COBOL, C/C++, IDL, HTML, ASP, VB 6.0, or TEXT

(12) Execution Division SQL
Steps

Number of embedded SQL steps in the COBOL execution division
Number of embedded SQL steps in the case of C/C++ or SQLJ
0 in the case of Java, IDL, HTML, ASP, VB 6.0, or TEXT

- Regardless of the [Document / Measurement Type] setting in the [Step Measurement - Measure] Option Settings, only program step
information is output.

- SQL steps are always output regardless of the [Output SQL information] form option setting.

5.8.2 List View CSV File
Although a measurement results file is normally saved in a dedicated format for STEPCOUNTER to read and write, it is possible to use
[Save As CSV File] to save it as a "CSV (Comma Separated Value)" file. However, STEPCOUNTER cannot reload saved CSV files.
Essentially, the information displayed in the list view is output in that format.

CSV File Output Example

"***** SIMPLIA MF-STEPCOUNTER ***** 08/09/2000 09:29:18 [UNICODE]"

"Program step information" 

"File", "Total Steps",,"Handwritten Steps",,"Embedded Steps", 

"File Name", "Valid", "Subtotal", "Valid", "Subtotal", "Valid", "Subtotal" 

"CMFSTP32.cpp", 4014, 6164, 1613, 2073, 2401, 4091 

"Total", 4014, 6164, 1613, 2073, 2401, 4091 

"Average", 4014, 6164, 1613, 2073, 2401, 4091

"Information of embedded member steps (include)" 

"File", "Breakdown of Steps", 

"File Name", "Valid","Subtotal" 

"childfrm.h", 23, 53 

"cmfstp32.h", 99, 161 

"Total", 122, 214 

"Average", 61, 107

About the Title Line

- [Title], [Date and Time  Created], and [Character Code] are output. For [Character Code], the character code (Shift JIS or Unicode)
specified for new measurement is output.

 
Output Item Description

Date and Time  Created

Date and Time  Created CSV File.

The display format with update is different according to the form of the region and the
language of OS setting.

When [Japanese (Japan)] is selected, it displays it by [yyyy/MM/dd HH:mm:ss].

It displays it by [MM/dd/yyyy HH:mm:ss] when selecting it excluding [Japanese
(Japan)].

About Detail Lines

- The output target is only the data displayed in the list view dialog. Therefore, if the data displayed has been narrowed down to the contents
of the folder specified in the [Display Folder] combo-box, only that data will be output.

About Output Items

- If [Do not output hidden items] is specified as a [CSV File] option, the output of items hidden in the list view dialog is prevented.
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- For details on each item, refer to Chapter 7 Description of Measurement Results.

About Average and Total Lines

- When [Save Selected Range As CSV File] is executed, average and total values are derived only from the information output to a CSV
file. If [Do not output average, or total lines] is specified as a [CSV File] option, these lines are not output.

5.9 Printing Measurement Results
If the dialog is displayed in form mode, it is possible to print the contents using the following procedure.

If it is displayed in list view mode, perform CSV file output, and print the results using an application such as spreadsheet software.

 
To Print Measurement Results

1. Select the [Print] command from the [File] menu.

2. In the Print Dialog Box, set the necessary items and click the [OK] button.

3. The measurement results are sent to the printer.

 
Item Description

Current Printer Displays the currently selected printer.

Document Type / Print
Range

Displays the selected document type for printing and the print range of each document.

Printing Range Specifies the print range for each document. (If the Specify button is depressed)

Number of copies Specifies the number of copies of each document to print. (If the Specify button is depressed)

Printer Settings Enables configuration of printer settings.

Referring to the printer manual for printer-specific settings, configure the settings that match the printer's capabilities.

This command is only enabled when the measurement results are displayed in form mode.

5.10 Step Measurement
This section explains how to operate Step Measurement.

5.10.1 Step Measurement (Measure All)
This method newly measures all target files and displays the measurement results.

 
To Measure All

1. Select the [Measure All] command from the [Measure] menu.

2. Measurement is started, and the measurement results are displayed on screen.

5.10.2 Step Measurement (Measure Changed)
This method measures only assets added in the process of [Edit Assets List] and displays the measurement results. If no assets were added
and only options were edited, it only displays the measurement results based on the updated options, without performing remeasurement.

 
To Measure Changed

1. Select the [Measure Changed] command from the [Measure] menu.

2. Measurement is started, and the measurement results are displayed on screen.
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In the following cases, measurement of the changed sections cannot be performed.

1. When performing new measurement

2. When assets have been deleted through asset list editing

3. When search paths have been added/deleted by setting [Step Measurement - Search Path] options

4. When the setting of [Measure embedded members] as a [Step Measurement - Measure] option has been changed

5. When the setting of [Measure embedded SQL] as a [Step Measurement - Measure] option has been changed

6. When the setting of [Search in sub folders] as a [Step Measurement - Measure] option has been changed

7. When the setting of [Measure blank lines] as a [Step Measurement - Measure] option has been changed

8. When the setting of [Measure blank lines as comments] as a [Step Measurement - Measure] option has been changed

9. When the setting of [Measure lines with only "{" & "}" as comments] as a [Step Measurement - Measure] option has been changed

10. When the setting of [Measure header files (*.h) when the folder is specified] as a [Step Measurement - Measure] option has been
changed

11. When the setting of [Measure by program ID] as a [Step Measurement - Measure] option has been changed from "enabled" state to
"disabled"

5.11 Options Settings
This section explains how to set various options.

5.11.1 [Step Measurement - Measure] Option Settings
Configure the settings for the types of measurement results from step measurement to be output and the measurement method.

 
To Configure Settings

1. Select the [Step Measurement - Measure] configuration command from the [Options] menu.

2. In the [Step Measurement - Measure] Options Dialog Box, set the necessary items.

 
Item Description

[Output program step
information]

Specify whether to output program source steps.

[Output step information of
embedded members]

Specify whether to output steps of embedded members expanded from the program
source.

[Measure embedded members] Specify whether to measure steps of embedded members.

[Measure embedded SQL] Specify whether to measure embedded SQL steps separately.

[Search in sub folders] Specify whether to target files located in subfolders for measurement when specifying
assets by folder specification. (*1)

[Measure blank lines] Specify whether to measure blank lines. Blank lines are measured if selected. Blank
lines are not measured if not selected. (A blank line is a line of 0 bytes in length or a line
consisting of only one-byte or two-byte blank spaces or tabs.)

[Measure blank lines as
comments]

Select this to measure blank lines as comments. Blank lines are measured as blank lines
if not selected. This is not selectable if blank lines are not to be measured. (A blank line
is a line of 0 bytes in length or a line consisting of only one-byte or two-byte blank
spaces or tabs.)
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Item Description

[Measure lines with only "{" &
"}" as comments]

Change the method for measuring lines with only "{" & "}". Lines with only "{" & "}"
are measured as comments if selected. However, lines with "{ }" are considered to be
valid lines. Lines with only "{" & "}" are measured as valid lines if not selected.

[Measure by program ID] Specify whether to perform measurement by program ID when the language category
is COBOL. If one source file contains multiple programs, subprograms are also
measured.

[Measure header files (*.h) when
the folder is specified]

Specify whether to measure header files as program step information when the
language category is C/C++. (*2, *3)

*1: The [Search in sub folders] measurement option is applied only to program step measurement, and the search path for embedded member
measurement includes only the specified folders.

*2: If the language category is [Auto-detect], program step information is always measured and displayed.

*3: If the [Measure embedded members] measurement option is enabled, this function is disabled. Header files are measured as embedded
information.

To apply the changes to the measurement results, it is necessary to execute [Measure All] or [Measure Changed]. However, when changing
[Measure embedded members], [Measure embedded SQL], [Search in sub folders], [Measure blank lines], [Measure blank lines as
comments], [Measure lines with only "{" & "}" as comments], [Measure by program ID], or [Measure header files (*.h) when the folder
is specified], it is necessary to execute [Measure All].

5.11.2 [Step Measurement - Display] Option Settings
Set information related to the dialog display format and the list view dialog for step measurement. For details on the variation measurement
related settings, refer to 5.11.9 [Measure Variation - Display] Option Settings.

 
To Configure Settings

1. Select the [Step Measurement - Display] configuration command from the [Options] menu.

2. In the [Step Measurement - Display] Options Dialog Box, set the necessary items.

 
Item Description

[Display Initial Dialog]
Specify whether to display the measurement results in the Form mode or the List view
mode.

[Display file information]
Specify whether to initially display or hide the type, size, and update date of file
information.

[Display SQL steps] Specify whether to initially display or hide SQL and ETC of SQL information.

[Display SQL ratio] Specify whether to initially display or hide the SQL ratio of SQL information.

[Display comments] Specify whether to initially display or hide comment steps.

[Display comment ratio] Specify whether to initially display or hide the comment ratio and the Javadoc ratio.

[Display embedded information] Specify whether to initially display or hide items by embedded type for program
information, and embedded information for embedded member information.

[Display folder name] Specify whether to initially display or hide the folder name.

[Minimum Value of Comment
Ratio]

Set the lower limit of the comment ratio. Comment ratios below the set value are
indicated in red.
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To apply the changes to the measurement results, it is necessary to execute [Measure All] or [Measure Changed]. When changing only the
display format without performing measurement, execute [Measure Changed].

5.11.3 [Step Measurement - Search Path] Option Settings
It is possible to set up to 10 paths to folders in which embedded files expanded in the source program are located.

 
To Configure Settings

1. Select the [Step Measurement - Search Path] configuration command from the [Options] menu.

2. In the [Step Measurement - Search Path] Options Dialog Box, set the necessary items.

 
Item Description

[Folder] The name of the folder to be added is displayed and can also be entered here.

[Folder List] A list of registered folder names is displayed.

[Browse] Browse folder names.

[Add] Select this to additionally register the folder name displayed in [Folder].

[Delete] Select this to unregister a registered folder name.

- To apply the changes to the measurement results, it is necessary to execute [Measure All].

- Duplicate registration of a single folder is not possible.

- The search order for measurement is the same as the order of registration.

- The folders in which measurement target files are located are automatically searched even if they are not registered in the search path.

- The order of priority in searches is the folders registered in the search path and then the folders in which asset files are located.

- The search path includes only the specified folders in searches, their subfolders are excluded.

5.11.4 [Step Measurement - CSV File] Option Settings
Set CSV file output related information.

 
To Configure Settings

1. Select the [Step Measurement - CSV File] configuration command from the [Options] menu.

2. In the [Step Measurement - CSV File] Options Dialog Box, set the necessary items.

 
Item Description

[Do not output hidden items] Specify whether to output hidden items.

[Do not output average, or total
lines]

Specify whether to output average and total lines.

These options are only enabled when the measurement results are displayed in list view mode.

5.11.5 [Step Measurement - Form] Option Settings
Set form dialog and form printing related information.
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To Configure Settings

1. Select the [Step Measurement - Form] configuration command from the [Options] menu.

2. In the [Step Measurement - Form] Options Dialog Box, set the necessary items.

 
Item Description

[Output file path] Specify whether to output the folder name.

[Output SQL information]
Specify whether to output SQL step information regardless of the [Measure embedded
SQL] setting in the [Step Measurement - Measure] options.
Zeros are output if [Measure embedded SQL] is not checked.

[Output the update date of the
file]

Specify whether to output the update date of the file.

[Note] Set a note to be printed on the form (up to 30 bytes).

To apply the changes in these items other than "Note" to the measurement results, it is necessary to execute [Measure All] or [Measure
Changed].

5.11.6 [Step Measurement - Auto-detection (Java)] Option Settings
Set handwritten start/end identifier related information to identify handwritten parts during measurement of auto-generated Java source.

The range of lines including the identifies specified here is measured as handwritten and the measurement results are displayed as
handwritten steps. The others are then measured as auto-generation and the measurement results are displayed as embedded steps.

For details on measurement criteria, refer to "4.1.5 Auto-generated Java Source Measurement Criteria".

 
To Configure Settings

1. Select the [Step Measurement - Auto-detect Java] configuration command from the [Options] menu.

2. In the [Step Measurement - Auto-detection (Java)] Options Dialog Box, set the necessary items.

 
Item Description

[Display error for
mismatched identifiers]

- To enable the display of errors for mismatched identifiers during measurement
Click [Display error for mismatched identifiers] so that it is selected.

[Identifiers]
Registered handwritten start identifiers, handwritten end identifiers, and comments are
displayed. Multiple selections are possible. (Up to 100 pairs of identifiers can be specified.)

[Read]
To register the contents of an identifier file storing identifier information in the [Identifier] list,
click the [Read] button. The [Browse Files] dialog box is displayed. At this time, the identifiers
registered in the [Identifier] list are deleted.

[Write]
To save the registered identifiers displayed in the [Identifier] list as an identifier list file, click
the [Write] button. The [Browse Files] dialog box is displayed.

[Add]
To add a new identifier to [Identifiers], click the [Add] button. The Specify Identifying String
Dialog Box is displayed.

[Delete]
Click the identifier to be deleted in [Identifiers] and click the [Delete] button. Multiple selections
are possible.

The following identifiers are pre-registered as standard.

 
Start Identifier End Identifier Comment

// >> 外部アジャスト対象の開始位置 // >> 外部アジャスト対象の終了位置 CBMBuilder
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Start Identifier End Identifier Comment

//>>ユーザ領域開始 //ユーザ領域終了<<
User area protection
tool

<!-->>ユーザ領域開始 <!-ユーザ領域開始<<-->
User area protection
tool

//******************** 変更可能領域 開始

********************
//******************** 変更可能領域 終了

********************
User area protection
tool

To apply the changes to the measurement results, it is necessary to execute [Measure All] or [Measure Changed].

 
About Multiple Selections

- To Specify Range

Click the first item of the target range, and while holding down the Shift key, click the last item. Alternatively, while holding down the
Shift key, move on items using the up arrow and down arrow keys to specify the selection. When using only the mouse, surround the
items to be selected by dragging the mouse to specify the range of selection.

- To Specify Individually

Click items while holding down the Ctrl key. Alternatively, while holding down the Ctrl key, move on items with the up arrow and down
arrow keys and specify items using the space key.

5.11.7 [Step Measurement - Auto-detection (VB 6.0)] Option Settings
Set start/end identifier related information to identify auto-generation sections during Visual Basic 6.0 source measurement.

The range of lines including the identifiers specified here is measured as auto-generation and the measurement results are displayed as
embedded steps. The others are then measured as handwritten and the measurement results are displayed as handwritten steps. (This is the
opposite to the Java auto-detection option, so caution is necessary.)

For details on measurement criteria, refer to "4.1.9 Visual Basic 6.0 Measurement Criteria".

 
To Configure Settings

1. Select the [Step Measurement - Auto-detect VB 6.0] configuration command from the [Options] menu.

2. In the [Step Measurement - Auto-detection (VB 6.0)] Options Dialog Box, set the necessary items.

 
Item Description

[Display error for
mismatched identifiers]

- To enable the display of errors for mismatched identifiers during measurement
Click [Display error for mismatched identifiers] so that it is selected.

[Identifiers]
Registered handwritten start identifiers, handwritten end identifiers, and comments are
displayed. Multiple selections are possible. (Up to 100 pairs of identifiers can be specified.)

[Read]
To register the contents of an identifier file storing identifier information in the [Identifier] list,
click the [Read] button. The [Browse Files] dialog box is displayed. At this time, the identifiers
registered in the [Identifier] list are deleted.

[Write]
To save the registered identifiers displayed in the [Identifier] list as an identifier list file, click
the [Write] button. The [Browse Files] dialog box is displayed.

[Add]
To add a new identifier to [Identifiers], click the [Add] button. The Specify Identifying String
Dialog Box is displayed.

[Delete]
Click the identifier to be deleted in [Identifiers] and click the [Delete] button. Multiple selections
are possible.

The following identifiers are pre-registered as standard.
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Start Identifier End Identifier Comment

VERSION 5.00 Attribute VB_Exposed VB 6.0(*.frm)

VERSION 1.0 CLASS Attribute VB_Exposed VB 6.0 (*.cls etc.)

The identifiers pre-defined as standard for VB6.0 are not based on the published specifications from Microsoft. Therefore, edit or add
identifiers if measurement is inaccurate.

To apply the changes to the measurement results, it is necessary to execute [Measure All] or [Measure Changed].

5.11.8 [Measure Variation - Measure] Option Settings
Configure the settings for the types of measurement results from variation measurement to be output and the measurement method.

 
To Configure Settings

1. Select the [Measure Variation - Measure] configuration command from the [Options] menu.

2. In the [Measure Variation - Measure] Options Dialog Box, set the necessary items.

 
Item Description

[Search in sub folders] Specify whether to target files located in subfolders for measurement when specifying
assets by folder specification.

[Valid lines only] Specify whether to measure variations of valid lines only. To include comment lines in
measurement, do not select this option.

[Measure blank lines] Specify whether to measure blank lines. Blank lines are measured as comments if this
is selected. Blank lines are not measured if this is not selected. (The blank line is a line
of 0 bytes in length or a line consisting of only one-byte or two-byte blank spaces or
tabs.)    

[Measure lines with only "{" &
"}" as comments]

Change the method for measuring lines with only "{" & "}". Lines with only "{" & "}"
are measured as comments if selected. However, lines with "{ }" are considered to be
valid lines. Lines with only "{" & "}" are measured as valid lines if not selected.

[Ignore multiple spaces between
words]

Specify whether to consider blank lines or spaces between words that differ in number
between old assets and new assets to be a match. Different spaces are considered to be
matches if this is selected. (*1, *2)

[Distinguish between uppercase
and lowercase letters]

Specify whether to distinguish between uppercase and lowercase letters in old assets
and new assets. Measurement is case-sensitive if this is selected.
Example: "int a;" <=> "int A;"

[Consider comment range] Specify whether to consider lines that are not regarded as comments, such as C/C++ and
Java /* ~ */ comments, but included in the comment range, as comments. These lines
are considered to be comments if this is selected.
(-> See "4.2 Variation Measurement Criteria".)

*1: It is assumed that the Program (C language) was fixed as follows. (Hereafter, the blank is written by △. )

    long△△I,j,max,ten_sv;

          ↓

    long△I,j,max,ten_sv; ・・"One digit blank" is deleted.
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- To measure it disregarding a blank number of null line and word space, [Ignore multiple spaces between words] is selected.
The measurement "Agreement" results when the correction measurement is executed by using the File before and after fix.

- Please do not select [Ignore multiple spaces between words] when you want to measure the blank of null line and the word space as it
is.In that case, "One row corrected" measurement results because it detects a blank difference.

*2: It is assumed that the Program (COBOL language) was Corrected as follows.(Hereafter, the blank is written by △. )

    MOVE "△" TO DATA1.

              ↓

    MOVE "△△" TO DATA1. ・・One digit is given at the blank of the constant value in an effective row. (Change at the blank from 1 to
2 digits. )

- The modification of the number of the blank in the constant value enclosed within two single or double quotation mark is judged to be
a effective modification as a program code.Therefore, when the variation measurement is performed by using the file before and after
the modification, the measurement result will be "one line modification" regardless of the selection of [Ignore multiple spaces between
words].

To apply the changes to the measurement results, it is necessary to execute [Measure All].

5.11.9 [Measure Variation - Display] Option Settings
Configure the settings for the types of measurement results from variation measurement to be output and the measurement method.

 
To Configure Settings

1. Select the [Measure Variation - Display] configuration command from the [Options] menu.

2. In the [Measure Variation - Display] Options Dialog Box, set the necessary items.

 
Item Description

[Display file information] Specify whether to initially display the file type, update date, and file size.

[Display folder name] Specify whether to initially display the folder name.

To apply the changes to the measurement results, it is necessary to execute [Measure All].

5.11.10 [Common - Extension] Option Settings
The extensions of assets to be measured can be changed.

- Up to 10 user-defined extensions can be added for each language type of each language category.

- One extension consists of 10 or less characters. Two-byte characters cannot be used.

- The same identifier can be specified more than once for different language categories, but not for different language types.

- Files of the specified extension is measured based on the comment standards of the specified language category and language type.

- The associated language type is shown in the type column of the measurement results and output to the measurement results dialog and
a CSV file.
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To Configure Settings

1. Select the [Common - Extension] configuration command from the [Options] menu.

2. In the [Common - Extension] Options Dialog Box, set the necessary items.

 
Item Description

[Extension] A list of language categories, language types, extensions, and comments is displayed.

[Read]
To read the contents of an extension file storing extension information into the [Extension] list,
click the [Read] button. The [Browse Files] dialog box is displayed. At this time, the extensions
contained in the [Extension] list are deleted.

[Write]
To save the registered extensions displayed in the [Extension] list as an extension list file, click
the [Write] button. The [Browse Files] dialog box is displayed.

[Update]
To update [Extension] with new extensions, click the [Update] button. The Change Extensions
Dialog Box is displayed.

[Initialize]
To initialize added extension information, click the [Initialize] button. The extension list is set to
Default Extensions.

To apply the changes to the measurement results, it is necessary to execute [Measure All].

5.11.10.1 Default Extensions
The default extensions are as follow.

 
Language Category Language Type Extension

COBOL COBOL *.cbl;*.cob;*.cobol;*.scob;*.pco

C/C++ C/C++ *.c;*.cpp;*.h;*.rc

JAVA JAVA *.java

  SQLJ *.sqlj

IDL IDL *.idl

Auto-generated JAVA JAVA *.java

  SQLJ *.sqlj

HTML/JSP/JS/CSS HTML *.html;*.htm

  JSP *.jsp;*.jspf;*.tag;*.tagx;*.tagf

  VB.NET *.vb

  VBScript *.vbs

  JavaScript *.js

  StyleSheet *.css

.NET (ASP/C#/VB)/
HTML/JS/CSS

ASP.NET *.asp;*.asax;*.ascx;*.aspx

  C# *.cs

  VB.NET *.vb

  VBScript *.vbs

  HTML *.html;*.htm

  JScript *.js

  StyleSheet *.css
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Visual Basic 6.0 VB 6.0 *.frm;*.bas;*.cls;*.ctl;*.pag;*.dsr

TEXT TEXT *.txt

5.11.11 [Common - Error Check] Option Settings
It sets about the behaviour when an error occurs during measurement processing.

 
To Configure Settings

1. Select the [Common - Error Check] configuration command from the [Options] menu.

2. In the [Common - Error Check] Options Dialog Box, set the necessary items.

 
Item Description

[Continue measurement

displaying messages]

Specify whether to continue measurement without displaying the error messages during
measurement processing.

5.12 Command Line
This section explains various command line parameters and return values. Creating a shortcut or a batch file specifying a command makes
it simple to repeat standard measurement periodically.
If only a command with no parameter settings is executed, the MF-STEPCOUNTER dialog is displayed.

5.12.1 New Measurement
Specify various options for command line execution and perform new measurement.

Command

CMFSTP32.EXE [-TYPE STP/MOD] Target File/Folder -LANG Language Category [-FORCE] [-CHAR SJIS/UNICODE] 

[-CSV CSV File Name/Output Destination Folder Name] [-LOG Results Log File Name] [Options]

The parameters enclosed with [] are optional.

Parameters

The "-TYPE" switch specifies the measurement type. The default type is step measurement.

STP: Step Measurement

MOD: Variation Measurement

"Target File/Folder" specifies the measurement target file or folder. This cannot be omitted for new measurements.

When performing step measurement: Specify the measurement target file or folder.

When performing variation measurement: Specify the old folder and the new folder, separating them with a one-byte space.

The "-LANG" switch specifies the language category of the measurement target. This cannot be omitted for new measurements.

For the language category, specify any one of the following values.

 
Language Category Measurement Criteria

ALL 4.1.1 Auto-detection Measurement Criteria

COBOL 4.1.2 COBOL Measurement Criteria

C 4.1.3 C/C++ Measurement Criteria
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Language Category Measurement Criteria

JAVA 4.1.4 Java Measurement Criteria

IDL 4.1.6 IDL Measurement Criteria

JAVAAUTO 4.1.5 Auto-generated Java Source Measurement Criteria

HTML 4.1.7 HTML/JSP/JS/CSS Measurement Criteria

DOTNET 4.1.8 .NET (ASP/C#/VB)/HTML/JS/CSS Measurement Criteria

VB 4.1.9 Visual Basic 6.0 Measurement Criteria

TEXT 4.1.10 TEXT Measurement Criteria

The "-FORCE" switch, if specified, lets measurement continue even if an error related to a target file (such as an open error or a code
conversion error) occurs.

The "-CHAR" switch specifies the character code of the asset. The default code is Shift JIS.

SJIS: Shift JIS is used.

UNICODE: UNICODE is used.

The "-CSV" switch specifies the output destination for the measurement results CSV file. The default destination is the folder specified in
the "TEMP" environment variable.

CSV File Name: The file with the specified file (*.csv) name is output.

Output Destination Folder Name: The file named along with date and time as "mfstp32_MMDDYYYYHHMMSS.csv" is output to the
specified folder.

The "-LOG" switch specifies the output destination for the measurement results log file. The default destination is the folder specified in
the "TEMP" environment variable. The file named along with date and time as "mfstp32_MMDDYYYYHHMMSS.log" is output.

Results Log File Name: The file with the specified file (*.log) name is output.

The switches shown in the following table can be specified as switches of "Options".

If no switch is specified, the default value shown in the following table is used.

Depending on the measurement type ("-TYPE" switch) setting, the available switches vary.

 

Switch Parameter Description
Default
Value

TYPE Switch

STP MOD

[Step Measurement - Measure] Options

-PGM
ON: Output
OFF: Do not output

Output of program step information ON Yes -

-INC
ON: Output
OFF: Do not output

Output of step information of embedded
members

ON Yes -

-CPYCNT
ON: Measure
OFF: Do not measure

Measure embedded members OFF Yes -

-SQL
ON: Measure
OFF: Do not measure

Measure embedded SQL ON Yes -

-STPSUBFLD
ON: Search
OFF: Do not search

Search in sub folders ON Yes -
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Switch Parameter Description
Default
Value

TYPE Switch

STP MOD

-STPBLK
ON: Measure
OFF: Do not measure

Measure blank lines ON Yes -

-COMMBLK
ON: Measure as comments
OFF: Measure as blank lines

Measure blank lines as comments OFF Yes -

-STPBRC
ON: Measure
OFF: Do not measure

Measure lines with only "{" & "}" as
comments

OFF Yes -

-H
ON: Measure
OFF: Do not measure

Measure header files (*.h) ON Yes -

-PGMID
ON: Measure
OFF: Do not measure

Measure by program ID ON Yes -

[Step Measurement - Display] Options

-DSPFRM
FRM: Form
LIST: List view

Display format LIST Yes -

-LSTFILE
ON: Display
OFF: Do not display

Display file information ON Yes -

-LSTSQLCNT
ON: Display
OFF: Do not display

Display SQL steps ON Yes -

-LSTSQLRAT
ON: Display
OFF: Do not display

Display SQL ratio ON Yes -

-
LSTCOMMCN
T

ON: Display
OFF: Do not display

Display comments ON Yes -

-
LSTCOMMRA
T

ON: Display
OFF: Do not display

Display comment ratio ON Yes -

-LSTINC
ON: Display
OFF: Do not display

Display embedded information ON Yes -

-LSTFLD
ON: Display
OFF: Do not display

Display folder name ON Yes -

[Step Measurement - Search Path] Options

-PATHLST
PATH1*PATH2*......PATH1
0

Search path (use "*" as a delimiter when
specifying multiple paths)

None Yes -

[Step Measurement - CSV File] Options

-NONDSPITEM
ON: Do not output
OFF: Output

Do not output hidden items ON Yes -

-TOTAVE
ON: Do not output
OFF: Output

Do not output average, or total lines OFF Yes -

[Step Measurement - Form] Options

-PRTPATH
ON: Print
OFF: Do not print

Print file path names ON Yes -

[Step Measurement - Auto-detection (Java)] Options

-JAVAFILE File path JAVA automatic identifier file None Yes -

[Step Measurement - Auto-detection (VB 6.0)] Options

-VBFILE File path VB 6.0 automatic identifier file None Yes -
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Switch Parameter Description
Default
Value

TYPE Switch

STP MOD

[Measure Variation - Measure] Options

-MODSUBFLD
ON: Search
OFF: Do not search

Search in sub folders ON - Yes

-VALID
ON: Measure
OFF: Do not measure

Valid lines only ON - Yes

-MODBLK
ON: Measure
OFF: Do not measure

Measure blank lines OFF - Yes

-MULBLK
ON: Ignore
OFF: Do not ignore

Ignore multiple spaces between words OFF - Yes

-MODBRC
ON: Measure
OFF: Do not measure

Measure lines with only "{" & "}" as
comments

OFF - Yes

-UPPER
ON: Distinguish
OFF: Do not distinguish

Distinguish between uppercase and
lowercase letters

OFF - Yes

-COMM
ON: Considered
OFF: Not considered

Consider comment range OFF - Yes

[Measure Variation - Display] Options

-FLDINFO
ON: Display
OFF: Do not display

Display folders ON - Yes

-FILEINFO
ON: Display
OFF: Do not display

Display file information ON - Yes

[Common - Extension] Options

-EXTFILE File path Customized extension file None Yes Yes

Return Values

Possible return values of "CMFSTP32.EXE" after measurement results are output are as follow.

0: Normal end.

1: Normal end (but a measurement error occurred).

3: Output of the measurement results log failed.

4: Generation of the measurement results file (*.csv) failed.

5: An error occurred in asset reading.

7: An error occurred in external file (*.AJD) reading.

8: A double start error occurred.

9: A command line error occurred.

5.12.2 Remeasurement
It is possible to specify measurement results (the measurement results file [*.STP]) in the MF-STEPCOUNTER dialog to perform
remeasurement under the same conditions.

Command

CMFSTP32.EXE Measurement Results File (*.STP) [-FORCE] [-CSV CSV File Name/Output Destination Folder 

Name] [-LOG Results Log File Name] [Options]

The parameters enclosed with [] are optional.
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Parameters

For "Measurement Results File (*.STP)", specify a measurement results file (*.STP) that stores the results of step measurement or variation
measurement in the MF-STEPCOUNTER dialog. This cannot be omitted.

The measurement type, the language category, the assets, and the character code cannot be specified because those specified when the
measurement results file (*.STP) was saved are applied.

If the -CHAR option or the -LANG option is specified, a command error occurs.

The "-FORCE" switch, if specified, lets measurement continue even if an error related to a target file (such as an open error or a code
conversion error) occurs.

The "-CSV" switch specifies the output destination for the measurement results CSV file. The default destination is the folder specified in
the "TEMP" environment variable.

CSV File Name: The file with the specified file name is output.

Output Destination Folder Name: The file named along with date and time as "mfstp32_MMDDYYYYHHMMSS.csv" is output to the
specified folder.

The "-LOG" switch specifies the output destination for the measurement results log file. The default destination is the folder specified in
the "TEMP" environment variable. The file named along with date and time as "mfstp32_MMDDYYYYHHMMSS.log" is output.

Results Log File Name: The file with the specified file name is output.

About Switches of "Options"

The switches of each option are similar to those for new measurement, with the following exceptions.

If the measurement option, the search path option, or the variation measurement option is omitted, the option specified when the
measurement results file (*.STP) was saved is applied. To change options, create the measurement results file (*.STP) again.

Return Values

Possible return values of "CMFSTP32.EXE" after measurement results are output are as follow.

0: Normal end.

1: Normal end (but a measurement error occurred).

3: Output of the measurement results log failed.

4: Generation of the measurement results file (*.csv) failed.

5: An error occurred in asset reading.

6: An error occurred in results file (*.stp) reading.

7: An error occurred in external file (*.AJD) reading.

8: A double start error occurred.

9: A command line error occurred.

5.12.3 Usage Example
In the following example, the installation destination is assumed to be "c:\Program Files\SIMPLIA\MF-STEPCOUNTER".

When specifying only CMFSTP32.EXE

Only this tool is started. For details on the subsequent operations, refer to New Measurement or 5.4 Reading Measurement Results Files.

Description of Parameters

FORCE
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=> Continues measurement even if a measurement error occurs in the measurement target file.

Usage Example

c:\>"c:\Program Files\SIMPLIA\MF-STEPCOUNTER\CMFSTP32.exe"

It starts SIMPLIA MF-STEPCOUNTER.

c:\>"c:\Program Files\SIMPLIA\MF-STEPCOUNTER\CMFSTP32.exe" -force

It starts SIMPLIA MF-STEPCOUNTER. It also continues measurement even if a measurement error occurs in the measurement target file.

 
When specifying a measurement target file as a new measurement (step measurement) argument

This newly measures the measurement target file based on the measurement criteria of the specified language category and outputs the
measurement results.

However, only a single file can be specified as the target file. In addition, wildcard specification (file specification using * or ?) is not
supported. To measure multiple files, specify the folder as below.

Description of Parameters

LANG Language Category

=> Performs new measurement based on the measurement criteria of the specified language category. If this is not specified, a parameter
error occurs.

CHAR Character Code

=> Specifies the character code used for measurement.

CSV CSV File Name (*.CSV)

=> Saves the measurement results as a CSV file and ends the processing.

If a file with the same name exists at the CSV file output destination, the file is overwritten. After measurement, a CSV file is output and
the process is closed.

CSV Output Destination Folder Name

=> Outputs the measurement results to the output destination folder and ends the processing. The output CSV file is named along with date
and time as "mfstp32_MMDDYYYYHHMMSS.csv".

If a file with the same name exists at the CSV file output destination, the file is overwritten. After measurement, a CSV file is output and
the process is closed.

Usage Example

c:\>"c:\Program Files\SIMPLIA\MF-STEPCOUNTER\CMFSTP32.exe" d:\work\test.c -lang c -char sjis -force

This newly measures the measurement target file test.c using the Shift-JIS character code, based on the measurement criteria of the C/C+
+ language category, outputs the measurement results to mfstp32_MMDDYYYYHHMMSS.csv in the folder specified in the "TEMP"
environment variable, and ends the processing. It also continues measurement even if a measurement error occurs in the measurement target
file.

c:\>"c:\Program Files\SIMPLIA\MF-STEPCOUNTER\CMFSTP32.exe" d:\work\test.c -lang c -csv d:\work\csv

\test.csv

This newly measures the measurement target file test.c based on the measurement criteria of the C/C++ language category, outputs the
measurement results to test.csv, and ends the processing.

c:\>"c:\Program Files\SIMPLIA\MF-STEPCOUNTER\CMFSTP32.exe" d:\work\test.c -lang c -csv d:\work\csv

This newly measures the measurement target file test.c based on the measurement criteria of the C/C++ language category, outputs the
measurement results to mfstp32_MMDDYYYYHHMMSS.csv, and ends the processing.
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When specifying a measurement target folder as a new measurement (step measurement) argument

This newly measures source files in the measurement target folder based on the measurement criteria of the specified language category and
outputs the measurement results.

Measurement target source files are those with the specified extensions associated with the language category.

Description of Parameters

FORCE

=> Continues measurement even if a measurement error occurs in the measurement target file.

LANG Language Category

=> Performs new measurement based on the measurement criteria of the specified language category. If this is not specified, a parameter
error occurs.

CHAR Character Code

=> Specifies the character code used for measurement.

CSV CSV File Name (*.CSV)

=> Saves the measurement results as a CSV file.

If a file with the same name exists at the CSV file output destination, the file is overwritten. After measurement, a CSV file is output and
the process is closed.

CSV Output Destination Folder Name

=> Outputs the measurement results to the output destination folder. The output CSV file is named named along with date and time as
"mfstp32_MMDDYYYYHHMMSS.csv".

If a file with the same name exists at the CSV file output destination, the file is overwritten. After measurement, a CSV file is output and
the process is closed.

Usage Example

c:\>"c:\Program Files\SIMPLIA\MF-STEPCOUNTER\CMFSTP32.exe" d:\work -lang c -char unicode -force

This newly measures measurement target files in the measurement target folder work using the UNICODE character code, based on the
measurement criteria of the C/C++ language category, outputs the measurement results to mfstp32_MMDDYYYYHHMMSS.csv in the
folder specified in the "TEMP" environment variable, and ends the processing. It also continues measurement even if a measurement error
occurs in the measurement target file.

c:\>"c:\Program Files\SIMPLIA\MF-STEPCOUNTER\CMFSTP32.exe" d:\work -lang c -csv d:\work\csv\test.csv

This newly measures measurement target files in the measurement target folder work based on the measurement criteria of the C/C++
language category, outputs the measurement results to test.csv, and ends the processing.

c:\>"c:\Program Files\SIMPLIA\MF-STEPCOUNTER\CMFSTP32.exe" d:\work -lang c -csv d:\work\csv

This newly measures measurement target files in the measurement target folder work based on the measurement criteria of the C/C++
language category, outputs the measurement results to mfstp32_MMDDYYYYHHMMSS.csv, and ends the processing.

 
When specifying a measurement results file as a remeasurement (step measurement) argument

This reads and measures a specified measurement results file (*.STP) and saves the measurement results as a CSV file.

Description of Parameters

FORCE

=> Continues measurement even if a measurement error occurs in the measurement target file.

CSV CSV File Name (*.CSV)
=> Saves the measurement results as a CSV file.
If a file with the same name exists at the CSV file output destination, the file is overwritten. After measurement, a CSV file is output and
the process is closed.
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CSV Output Destination Folder Name

=> Outputs the measurement results to the output destination folder. The output CSV file is named along with date and time as
"mfstp32_MMDDYYYYHHMMSS.csv".
If a file with the same name exists at the CSV file output destination, the file is overwritten. After measurement, a CSV file is output and
the process is closed.

Usage Example

c:\>"c:\Program Files\SIMPLIA\MF-STEPCOUNTER\CMFSTP32.exe" d:\work\test.stp -force

This remeasures the measurement results file test.stp, outputs the measurement results to mfstp32_MMDDYYYYHHMMSS.csv in the
folder specified in the "TEMP" environment variable, and ends the processing. Measurement is continued even if an error occurs in the
measurement target file.

c:\>"c:\Program Files\SIMPLIA\MF-STEPCOUNTER\CMFSTP32.exe" d:\work\test.stp -csv d:\work\csv\test.csv

This remeasures the measurement results file test.stp, outputs the measurement results to test.csv, and ends the processing.

c:\>"c:\Program Files\SIMPLIA\MF-STEPCOUNTER\CMFSTP32.exe" d:\work\test.stp -csv d:\work\csv

This remeasures the measurement results file test.stp, outputs the measurement results to mfstp32_MMDDYYYYHHMMSS.csv, and ends
the processing.

For the measurement results file, the measurement target file/folder, and the CSV file/folder, specify the full path. Do specify only the file
name or a relative path.

To specify a measurement results file from an older version, save the file once in the Main dialog. Measurement results files saved using
an older version cannot be remeasured.

If the file name or folder name contains spaces, enclose the path in "".

Example: cmftstp32.exe "d:\work folder\test.stp"

To execute the command from the command prompt, specify the installation folder of this product in the PATH environment variable in
advance to simplify startup from the exe file name.
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Chapter 6 User Interface
This chapter explains the user interface of MF-STEPCOUNTER.

6.1 Menus
This section explains the various menus.

6.1.1 [File] Menu
 

Menu Command Function

New Measurement Performs new measurement and displays the measurement results on screen.

Read Reads an existing measurement results file and displays the measurement results on screen.

Edit Assets List Allows editing of a specified assets list by adding/deleting assets.

Save Saves the measurement results to the file.

Save As Saves the measurement results as a new file with the specified name.

Save Selected
Range As CSV File

Saves only the selected target file rows in the list view of the measurement results as a CSV
file.
(Enabled only in the List view mode. For details on how to change the display format, refer to
5.11.2 [Step Measurement - Display] Option Settings.)

Save As CSV File Saves the measurement results as a CSV file.
5.8.1 Form CSV File
5.8.2 List View CSV File

Print Sets printing related information and outputs the measurement results to the printer.
(Enabled only if the measurement results display format is Form. For details on how to
change the display format, refer to 5.11.2 [Step Measurement - Display] Option Settings.)

Recently Used Files Displays up to five previously handled measurement results files, in order from the latest. The
measurement results file selected here is read and the measurement results are displayed on
screen.

Related items

6.2 Toolbars

6.3 Shortcut Keys

6.1.2 [Measure] Menu
 

Menu Command Function

Measure All Remeasures measurement target files specified for all measurement and displays the
measurement results on screen. To apply changes in options to the measurement results, it is
necessary to execute this command.

Measure Changed Measures only files added in the process of [Edit Assets List] and displays the measurement
results.

When assets were deleted in the process of [Edit Assets List], this command cannot be used.
Use Measure All instead.

Related items

6.2 Toolbars

6.3 Shortcut Keys
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6.1.3 [Display] Menu
 

Menu Command Function

Toolbars Controls the display of the Main, Display Control, and Display Folder toolbars.

Status Bar Displays or hides the status bar.

File Information Displays or hides the type, size, and update date of file information. (*1)

SQL Steps Displays or hides SQL and ETC of SQL information. (*1)

SQL Ratio Displays or hides the SQL ratio of SQL information. (*1)

Comment Steps Displays or hides comments, Javadoc, and ETC. (*1)

Comment Ratio Displays or hides the comment ratio and the Javadoc ratio. (*1)

Embedded Type Displays or hides items by embedded type for program information, and embedded
information for embedded member information. (*1)

Folder Name Displays or hides the folder name. (*1)

Initialize Display Returns the display of each column to the state specified in the display options. (*1)

Previous Page Changes the display page in the current active document window to the previous page. (*2)

Next Page Changes the display page in the current active document window to the next page. (*2)

First Page Displays the first page in the current active document window. (*2)

Last Page Displays the last page in the current active document window. (*2)

Specify Page Displays the specified page in the current active document window. (*2)

*1: Enabled only if the measurement results display format is List view.
*2: Enabled only if the measurement results display format is Form.

Related items

6.2 Toolbars

6.3 Shortcut Keys

6.1.4 [Options] Menu
 

Menu Command Function

[Step Measurement - Measure]
Options

Allows setting of the type and information of step measurement.

[Step Measurement - Display]
Options

Allows specification of information related to the dialog display format and the
list view dialog.

[Step Measurement - Search
Path] Options

Allows setting of the paths to folders in which embedded files expanded in the
source program are located.

[Step Measurement - CSV File]
Options

Allows setting of CSV file output related information.

[Step Measurement - Form]
Options

Allows specification of form dialog and form printing related information.

[Step Measurement - Auto-
detection (Java)] Options

Allows specification of handwritten/auto-generation measurement related
information for auto-generated Java source measurement.

[Step Measurement - Auto-
detection (VB 6.0)] Options

Allows specification of handwritten/auto-generation measurement related
information for Visual Basic 6.0 source measurement.

[Measure Variation - Measure]
Options

Allows setting of the type and information of variation measurement.
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Menu Command Function

[Measure Variation - Display]
Options

Allows setting of the initial display of variation measurement.

[Common - Extension] Options
Allows setting of the extensions of assets of which steps or variations are
measured.

[Common - Error Check]
Options

Set the behaviour when an error occurs during the measurement process when
measuring steps or variations.

Related items

6.2 Toolbars

6.3 Shortcut Keys

6.1.5 [Windows] Menu
Use this menu when multiple windows are displayed, such as in cases where the embedded member step information window is displayed
separately from the program step information window in order to display the measurement results in a certain language such as COBOL
and C/C++.

 
Menu Command Function

Display
Overlapping

Cascades open windows in a manner that all the title bars are visible.

Align Vertically Tiles open windows vertically in a manner that all the windows are visible.

Align Horizontally Tiles open windows horizontally in a manner that all the windows are visible.

The title bar strings of currently displayed document windows are added as submenu items. Select an added submenu item to activate the
corresponding document window.

Related items

6.2 Toolbars

6.3 Shortcut Keys

6.2 Toolbars
 

Display Folder Toolbar

If measurement of target assets including subfolders is performed, the "Display Folder" toolbar provides a list of the subfolders and "All"
which indicates all of the measurement target files. Select one of these to view the measurement results by folder or view all of the
measurement results.

In the case of variation measurement, folders of the new version are used as the base.

(Enabled only in List view mode)
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Main Toolbar

 
Icon Corresponding Menu Command

New Measurement

Read

Save

Save As

Save Selected Range As CSV File

Save As CSV File

Print

Measure All

Measure Changed

Step Measurement Options

Variation Measurement Options

Common Options

MF-STEPCOUNTER Help

 
Display Control Toolbar

 
Icon Corresponding Menu Command

First Page

Previous Page

Next Page
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Icon Corresponding Menu Command

Last Page

File Information

SQL Steps

SQL Ratio

Comment Steps

Comment Ratio

Embedded Type

Folder Name

Related items

6.1.1 [File] Menu

6.1.2 [Measure] Menu

6.1.3 [Display] Menu

6.1.4 [Options] Menu

6.1.5 [Windows] Menu

6.3 Shortcut Keys

6.3 Shortcut Keys
 

Shortcut Keys for Menu Commands
 

Key Operation Corresponding Menu Command

+ New Measurement

+ Read

+ Edit Assets List

+ Save

+ Print

+ Measure All

+ Measure Changed

+ Previous Page

+
Next Page

+ First Page

+ Last Page

 
Other Shortcut Keys
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Key Operation Corresponding Menu Command

Scrolls up within the currently displayed page.

Scrolls down within the currently displayed page.

+ Moves to the top of the currently displayed page.

+ Moves to the bottom of the currently displayed page.

Related items

6.1.1 [File] Menu

6.1.2 [Measure] Menu

6.1.3 [Display] Menu

6.1.4 [Options] Menu

6.1.5 [Windows] Menu

6.2 Toolbars

6.4 Dialog Boxes
This section explains the various dialog boxes.

6.4.1 New Measurement 1/2 Dialog Box
Specify the language category and the target resource specification method.

 
Item Description

[Measurement Type] Select [Steps] or [Variations].
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Item Description

[Language Category]

Select the language of the target asset from the drop-down list box.
In the case of step measurement, [Auto-detection], [COBOL], [C/C++], [Java], [IDL],
[Auto-generated Java Source], [HTML/JSP/JS/CSS], [.NET (ASP/C#/VB)/HTML/JS/
CSS], [Visual Basic 6.0], and [TEXT] are selectable.

In the case of variation measurement, [Auto-detection], [COBOL], [C/C++], [Java],
[.NET (ASP/C#/VB)/HTML/JS/CSS], and [TEXT] are selectable.

If [Auto-detection] is selected, target files are measured according to Auto-detection
Measurement Criteria.

[Target Asset
Specification Method]

Select [File] to select measurement target assets using file as the unit.

Select [Folder] to select measurement target assets using folder as the unit. To specify
whether to search in subfolders, configure the setting in [Step Measurement - Measure]
Options or [Measure Variation - Measure] Options.

[Character Code]

Select [Shift JIS] or [UNICODE] as the character code of the measurement target asset.

[UNICODE] is compatible with UTF-8 or UCS2 (Big Endian or Little Endian) with BOM
(Byte Order Mark).

=> 6.4.2 New Measurement 2/2 Dialog Box (Step Measurement)

=> 6.4.3 New Measurement 2/2 Dialog Box (Variation Measurement)

6.4.2 New Measurement 2/2 Dialog Box (Step Measurement)
Specify measurement target assets. Depending on the [Target Asset Specification Method] selected in the [New Measurement 1/2] dialog
box, the [Specify target assets using the file] dialog or the [Specify target assets using the folder] dialog is displayed.

 
For [Specify target assets using the file]
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Item Description

[Registered Files] A list of registered file names (file names and folder names) is displayed. Multiple
selections are possible. (Used for deletion)

[Add] Click the [Add] button, and the [Specify File] dialog box is displayed. In this dialog box,
specify a file and click the [Open] button to add the file name to [Registered Files].
Multiple selections are also possible.

Selectable files are those with the extensions specified for each language type using the
extension option.

[Delete] Click the file name to be deleted from [Registered Files] and click the [Delete] button.
Multiple selections are also possible.

 
For [Specify target assets using the folder]

 
Item Description

[Folder] The name of the folder set to be referenced from the [Browse] button is displayed. Direct
manual entry is also available.

[Folder List] A list of registered folder names is displayed. Double-click a folder name, and the selected
folder name is displayed in the [Folder] edit box. Multiple selections are possible. (Used
for deletion)

[Browse] To browse folder names, click the [Browse] button. The [Browse for Folder] dialog box is
displayed.

[Add] With the [Folder] edit box displaying the folder name, click the [Add] button.

When [Search in sub folders] is enabled as a measurement option

In cases where a higher level folder has been registered, a lower level folder cannot be
registered.
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Item Description

In cases where a lower level folder has (or lower folders have) been registered, a higher
level folder cannot be registered.

[Delete] Click the folder name to be deleted from [Folder List] and click the [Delete] button.
Multiple selections are also possible.

6.4.3 New Measurement 2/2 Dialog Box (Variation Measurement)
Specify measurement target assets. Depending on the [Target Asset Specification Method] selected in the [New Measurement 1/2] dialog
box, the [Specify target assets using the file] dialog or the [Specify target assets using the folder] dialog is displayed.

Old and new files with different names can be compared if the [File] specification method is selected, but only files with the same name are
compared if the [Folder] specification method is selected. To include subfolders in the measurement, the subfolders must also have the same
name.

 
For [Specify target assets using the file]

 
Item Description

[Old File List] A list of registered file names (file names and folder names) is displayed. Files are
compared with the files with the same number in the new file list. Multiple selections are
possible. (Used for deletion)

[New File List] A list of registered file names (file names and folder names) is displayed. Files are
compared with the files with the same number in the old file list. Multiple selections are
possible. (Used for deletion)

[Add] Click the [Add] button, and the [Specify File] dialog box is displayed. In the dialog box,
specify a file and click the [Open] button to add the file name to the [File List].

- 54 -



Item Description

The files that can be selected are those with the extensions specified for each language type
(COBOL, JAVA, C/C++, .NET, or TEXT) using the extension option.

[Delete] Click the file name to be deleted from [Registered Files] and click the [Delete] button.
Multiple selections are also possible.

 
For [Specify target assets using the folder]

 
Item Description

[Old Folder List] A list of registered folder names is displayed. Folders are compared with the folders with
the same number in the new folder list. Multiple selections are possible. (Used for deletion)

[New Folder List] A list of registered folder names is displayed. Folders are compared with the folders with
the same number in the old folder list. Multiple selections are possible. (Used for deletion)

[Add] Click the [Add] button, and the [Browse for Folder] dialog box is displayed. In the dialog
box, specify a folder to add the folder to the [Folder List].

When [Search in sub folders] is enabled as a measurement option

In cases where a higher level folder has been registered, a lower level folder cannot be
registered.

In cases where a lower level folder has (or lower folders have) been registered, a higher
level folder cannot be registered.

[Delete] Click the folder name to be deleted from [Folder List] and click the [Delete] button.
Multiple selections are also possible.
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6.4.4 Edit Assets List Dialog Box (Step Measurement)
Edit the assets list specified for new measurement or the assets list updated after the reading of a measurement results file, by adding/deleting
assets. The [Edit Assets List (File)] dialog is displayed if the file specification method was selected for new measurement, or the [Edit Assets
List (Folder)] dialog is displayed if the folder specification method was selected.

 
For [Specify target assets using the file]

 
Item Description

[Registered Files] A list of registered file names (file names and folder names) is displayed. Multiple
selections are possible.

[Add] Click the [Add] button, and the [Specify File] dialog box is displayed. In this dialog box,
specify a file and click the [Open] button to add the file name to [Registered Files].
Multiple selections are also possible.

Selectable files are those with the extensions specified for each language type using the
extension option.

[Delete] Click the file name to be deleted from [Registered Files] and click the [Delete] button.
Multiple selections are also possible.
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For [Specify target assets using the folder]

 
Item Description

[Folder]
The name of the folder set to be referenced from the [Browse] button is displayed. Direct
manual entry is also available.

[Folder List]
A list of registered folder names is displayed. Double-click a folder name, and the selected
folder name is displayed in the [Folder] edit box. Multiple selections are possible.

[Browse]
To browse folder names, click the [Browse] button. The [Browse for Folder] dialog box is
displayed.

[Add]

With the [Folder] edit box displaying the folder name, click the [Add] button.

When [Search in sub folders] is enabled as a measurement option
In cases where a higher level folder has been registered, a lower level folder cannot be
registered.

In cases where a lower level folder has (or lower folders have) been registered, a higher
level folder cannot be registered.

[Delete]
Click the folder name to be deleted from [Folder List] and click the [Delete] button.
Multiple selections are also possible.

If the OK button is clicked after editing the assets list, the measurement results that have been displayed on screen are discarded
unconditionally, even if they are unsaved.

6.4.5 Edit Assets List Dialog Box (Variation Measurement)
Edit the assets list specified for new measurement, or edit the assets list after the reading of a measurement results file, by adding/deleting
assets. Depending on the target asset specification method selected for new measurement, the [Edit Assets List (File)] dialog or the [Edit
Assets List (Folder)] dialog is displayed.

Old and new files with different names can be compared if the [File] specification method is selected, but only files with the same name are
compared if the [Folder] specification method is selected. To include subfolders in the measurement, the subfolders must also have the same
name.
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For [Specify target assets using the file]

 
Item Description

[Old File List] A list of registered file names (file names and folder names) is displayed. Files are
compared with the files with the same number in the new file list. Multiple selections are
possible. (Used for deletion)

[New File List] A list of registered file names (file names and folder names) is displayed. Files are
compared with the files with the same number in the old file list. Multiple selections are
possible. (Used for deletion)

[Add] Click the [Add] button, and the [Specify File] dialog box is displayed. In the dialog box,
specify a file and click the [Open] button to add the file name to the [File List].

Selectable files are those of the extensions specified for each language type (COBOL,
JAVA, C/C++, .NET, or TEXT) using the extension option.

[Delete] Click the file name to be deleted from the [Old File List] or the [New File List] and click
the [Delete] button. Selected files will be deleted from both lists. Multiple selections are
also possible.

 

- 58 -



For [Specify target assets using the folder]

 
Item Description

[Old Folder List] A list of registered folder names is displayed. Folders are compared with the folders with
the same number in the new folder list. Multiple selections are possible. (Used for deletion)

[New Folder List] A list of registered folder names is displayed. Folders are compared with the folders with
the same number in the old folder list. Multiple selections are possible. (Used for deletion)

[Add] Click the [Add] button, and the [Browse for Folder] dialog box is displayed. In the dialog
box, specify a folder to add the folder to the [Folder List].

When [Search in sub folders] is enabled as a measurement option

In cases where a higher level folder has been registered, a lower level folder cannot be
registered.

In cases where a lower level folder has (or lower folders have) been registered, a higher
level folder cannot be registered.

[Delete] Click the folder name to be deleted from [Folder List] and click the [Delete] button.
Multiple selections are also possible.

6.4.6 Specify Pages Dialog Box
Specify the pages to display in the measurement results dialog in form mode.
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Item Description

[Pages] Set the pages to be displayed in the [Pages] edit box.

6.4.7 Print Dialog Box
Set printing related information.

 
Item Description

[Current Printer] Displays the currently selected printer.

[Document Type /
Print Range]

Displays the selected document type for printing and the print range of each document.

- To print documents

Click the document type of the documents to be printed so that it is selected.

- To change the printing range

Click the [Specify] button of each document. The Specify Print Range Dialog Box is
displayed.

- To change the number of copies

Click the [Specify] button of each document. The Specify Print Range Dialog Box is
displayed.

[Printer Settings] Change the printer and configure printer settings.

6.4.8 Specify Print Range Dialog Box
Set the range of pages to print and the number of copies.
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Item Description

[Document] The target document is displayed.

[Printing Range]

Select [All pages] or [Specify pages].

When [Specify Page] is selected, enter values in the [First page] and [Last page] edit boxes.
If "0" is specified for both, all pages are printed.

If "0" is specified for [Last page], the pages up to the last page are printed.

When specifying a page number other than "0" for [Last page], specify a page number other
than "0" for [First page].

[Number of copies] Set the number of copies to print in the [Number of copies] edit box.

6.4.9 [Step Measurement - Measure] Options Dialog Box
Using measurement options, configure the settings for the types of measurement results to be output and the measurement method to be
used.
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Item Description

[Document /
Measurement Type]

Selection of at least one is necessary.

- To output program step information

Click [Output program step information] so that it is selected.

- To output step information of embedded members

Click [Output step information of embedded members] so that it is selected.

If only [Output step information of embedded members] is selected and if sources such as
html or java sources containing no embedded member step information are measured,
program step information is output even if [Output program step information] is not
selected.

[Measurement
Method]

- To measure embedded members

Click [Measure embedded members] so that it is selected.

- To measure embedded SQL

Click [Measure embedded SQL] so that it is selected.

- To search in sub folders

Click [Search in sub folders] so that it is selected.

- To measure blank lines

Click [Measure blank lines] so that it is selected.
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Item Description

- To measure blank lines as comments

Click [Measure blank lines as comments] so that it is selected.

- To measure lines with only "{" & "}" as comments

Click [Measure lines with only "{" & "}" as comments] so that it is selected.

[COBOL
Measurement Method]

- To perform measurement by program ID when the language category is COBOL

Click [Measure by program ID] so that it is selected.

[C/C++ Measurement
Method]

- To measure header files as program step information when the language category is C/
C++

Click [Measure header files (*.h) when the folder is specified] so that it is selected.

If [Measure embedded members] is selected, [Measure header files (*.h) when the folder
is specified] is automatically unchecked and disabled.

6.4.10 [Step Measurement - Display] Options Dialog Box
Allows specification of information related to the dialog display format and the list view dialog.

 
Item Description

[Display Initial
Dialog]

- To output the measurement results in form mode

Click [Form] so that it is selected.
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Item Description

- To output the measurement results in list view mode

Click [List view] so that it is selected.

[List view] - When [List view] of [Display Initial Dialog] is selected, specify the following.

- To display file information

Click [Display file information] so that it is selected.

- To display the number of SQL steps

Click [Display SQL steps] so that it is selected.

- To display the SQL ratio

Click [Display SQL ratio] so that it is selected.

- To display comments

Click [Display comments] so that it is selected.

- To display the comment ratio

Click [Display comment ratio] so that it is selected.

- To display embedded information

Click [Display embedded information] so that it is selected.

- To display the folder name

Click [Display folder name] so that it is selected.

- To change the minimum value of comment ratio

Click the black downward-pointing triangle of [Minimum Value of Comment Ratio],
and select a value from the drop-down list. (Disabled for text measurement)

6.4.11 [Step Measurement - Search Path] Options Dialog Box
Specify search path related information.
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Item Description

[Folder] The name of the folder set to be referenced from the [Browse] button is displayed. Direct
manual entry is also available.

Click the [Add] button to add it to the folder list.

[Folder List] A list of registered folder names is displayed. Multiple selections are possible. (Up to 10
folder paths can be registered.)
Double-click a folder name, and the selected folder name is displayed in the [Folder] edit
box. If the [Browse] button is clicked here, that folder is initially displayed in the [Browse
for Folder] dialog box.

[Browse] To browse folder names, click the [Browse] button. The [Browse for Folder] dialog box is
displayed.

[Add] With the [Folder] edit box displaying the folder name, click the [Add] button to add the
folder name to [Folder List] as a search path.

[Delete] Click the folder name to be deleted from [Folder List] and click the [Delete] button.
Multiple selections are also possible.

6.4.12 [Step Measurement - CSV File] Options Dialog Box
Set CSV file output item related information.

- 65 -



 
Item Description

[Do not output hidden
items]

- To prevent the output of hidden items to a CSV file

Click [Do not output hidden items] so that it is selected.

[Do not output
average, or total lines]

- To prevent the output of average, or total lines to a CSV file

Click [Do not output average, or total lines] so that it is selected.

6.4.13 [Step Measurement - Form] Options Dialog Box
Allows specification of form dialog and form printing related information.
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Item Description

[Output file path]
- To output the folder name

Click [Output file path] so that it is selected.

[Output SQL
information]

- To output SQL step information

Click [Output SQL information] so that it is selected.

[Output the update
date of the file]

- To output the update date of the file

Click [Output the update date of the file] so that it is selected.

[Note]
- To set a note

Enter a 30-byte or shorter string in the [Note] edit box.

6.4.14 [Step Measurement - Auto-detection (Java)] Options Dialog Box
Allows specification of handwritten/auto-generation measurement related information for auto-generated Java source measurement.
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Item Description

[Display error for
mismatched
identifiers]

- To enable the display of errors for mismatched identifiers during measurement

Click [Display error for mismatched identifiers] so that it is selected.

[Identifiers]
Registered start identifiers, end identifiers, and comments are displayed. Multiple
selections are possible. (Up to 100 pairs of identifiers can be specified.)

[Read]
To register the contents of an identifier file storing identifier information in the [Identifier]
list, click the [Read] button. The [Specify File] dialog box is displayed. At this time, the
identifiers registered in the [Identifier] list are deleted.

[Write]
To save the registered identifiers displayed in the [Identifier] list as an identifier list file,
click the [Write] button. The [Specify File] dialog box is displayed.

[Add]
To add a new identifier to [Identifiers], click the [Add] button. The Specify Identifying
String Dialog Box is displayed.

[Delete]
Click the identifier to be deleted in [Identifiers] and click the [Delete] button. Multiple
selections are possible.

6.4.15 [Step Measurement - Auto-detection (VB6.0)] Options Dialog Box
Allows specification of handwritten/auto-generation measurement related information for Visual Basic 6.0 source measurement.
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Item Description

[Display error for
mismatched
identifiers]

- To enable the display of errors for mismatched identifiers during measurement

Click [Display error for mismatched identifiers] so that it is selected.

[Identifiers]
Registered start identifiers, end identifiers, and comments are displayed. Multiple
selections are possible. (Up to 100 pairs of identifiers can be specified.)

[Read]
To register the contents of an identifier file storing identifier information in the [Identifier]
list, click the [Read] button. The [Specify File] dialog box is displayed. At this time, the
identifiers registered in the [Identifier] list are deleted.

[Write]
To save the registered identifiers displayed in the [Identifier] list as an identifier list file,
click the [Write] button. The [Specify File] dialog box is displayed.

[Add]
To add a new identifier to [Identifiers], click the [Add] button. The Specify Identifying
String Dialog Box is displayed.

[Delete]
Click the identifier to be deleted in [Identifiers] and click the [Delete] button. Multiple
selections are possible.

6.4.16 [Measure Variation - Measure] Options Dialog Box
Using measurement options, configure the settings for the types of measurement results to be output and the measurement method to be
used.
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Item Description

[Measurement
Method]

- To search in sub folders

Click [Search in sub folders] so that it is selected.

- To measure only valid lines

Click [Valid lines only] so that it is selected.

- Measure blank lines

Click [Measure blank lines] so that it is selected.

- Measure lines with only "{" & "}" as comments

Click [Measure lines with only "{" & "}" as comments] so that it is selected.

- To ignore the number of spaces in blank lines or between words in measurement

Click [Ignore multiple spaces between words] so that it is selected.

- To distinguish between uppercase and lowercase letters in measurement

Click [Distinguish between uppercase and lowercase letters] so that it is selected.

- To consider multi-line comments such as lines from /* to */ in measurement

Click [Consider comment range] so that it is selected.

If [Valid lines only] is selected, [Measure blank lines] is disabled.

6.4.17 [Measure Variation - Display] Options Dialog Box
Using display options, set the initial display of variation measurement.
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Item Description

[Initialize] - To display file information

Click [Display file information] so that it is selected.

- To display the folder name

Click [Display folder name] so that it is selected.

6.4.18 [Common - Extension] Options Dialog Box
Change the extensions of assets.
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Item Description

[Extension] A list of language categories, language types, extensions, and comments is displayed.

[Read]
To read the contents of an extension file storing extension information into the [Extension]
list, click the [Read] button. The [Specify File] dialog box is displayed. At this time, the
extensions contained in the [Extension] list are deleted.

[Write]
To save the registered extensions displayed in the [Extension] list as an extension list file,
click the [Write] button. The [Specify File] dialog box is displayed.

[Update]
To update [Extension] with new extensions, click the [Update] button. The Change
Extensions Dialog Box is displayed.

[Initialize]
To return modified extension information to its initial state at installation, click the
[Initialize] button. The contents of the extension list are set to Default Extensions.

To apply the changes to the measurement results, it is necessary to execute [Measure All].

6.4.19 [Common - Error Check] Options Dialog Box
It sets about the behaviour when an error occurs during measurement processing.
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Item Description

[Error messages
during measurement
processing]

- To continue measurement without displaying messages

Click [Continue measurement without displaying messages] so that it is selected.

If selected, even if an error occurs during the measurement process, the measurement
process continues without displaying messages.

(Please check the error file (Folder set in the environment variable TEMP \
MF_STP32.ERR) after measurement has ended.)

6.4.20 Specify Identifying String (Java) Dialog Box
Set identifiers used to judge handwritten/auto-generation sections during auto-generated Java source measurement.
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Item Description

[Prefix] Specify the start identifier.

[Suffix] Specify the end identifier.

[Comment] Specify a comment for the identifiers.

6.4.21 Specify Identifying String (VB 6.0) Dialog Box
Set identifiers used to judge handwritten/auto-generation sections during Visual Basic 6.0 source measurement.

 
Item Description

[Prefix] Specify the start identifier.

[Suffix] Specify the end identifier.

[Comment] Specify a comment for the identifiers.

6.4.22 Change Extensions Dialog Box
Change extensions.

 
Item Description

[Language Category] Changing of the language category is prohibited.
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Item Description

[Language Type] Changing of the language type is prohibited.

[Extension]
Edit the extension string. To specify multiple extensions, separate extensions with a
comma (","). To delete an extension, clear the extension entry.

[Comment] The comment for the extension can be changed.

- If the extension is blank, no measurement target is displayed for this language category and language type.
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Chapter 7 Description of Measurement Results
This chapter explains the Measurement Results by MF-STEPCOUNTER.

7.1 Measurement Output Examples
This section provides measurement output examples.

7.1.1 Information of Embedded Member Steps (Form)
An output layout example (C/C++ form) of embedded member step information is shown below.

Click a link to refer to the details.

7.2.1 Sequence Number

7.2.2 Embedded Member Names

7.2.3 Breakdown of Steps

7.2.4 Location

7.2.5 Cumulative Total Steps

7.2.6 Number of Times Used

7.2.7 Used Program and Embedded Member Names

7.2.9 Subtotal

7.2.15 Update Date

7.2.18 Total

7.2.19 Average
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* The form image varies slightly depending on the language category.

Related items

7.1.2 Information of Embedded Member Steps (List View)

7.1.3 Program Step Information (Form)

7.1.4 Program Step Information (List View)

These sections provide output layout example (C/C++ form) for errors in the measurement target files.

7.1.2 Information of Embedded Member Steps (List View)
An output example (C/C++ List view) of embedded member step information is shown below.

Click a link to refer to the details.

7.2.3 Breakdown of Steps

7.2.4 Location

7.2.5 Cumulative Total Steps

7.2.6 Number of Times Used

7.2.7 Used Program and Embedded Member Names

7.2.16 File Information

7.2.17 Folder Name
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7.2.18 Total

7.2.19 Average

* The List view image varies slightly depending on the language category.

Related items

7.1.1 Information of Embedded Member Steps (Form)

7.1.3 Program Step Information (Form)

7.1.4 Program Step Information (List View)

These sections provide output layout example (C/C++ List view) for errors in the measurement target files.

7.1.3 Program Step Information (Form)
An output layout example (C/C++ form) of program step information is shown below.

Click a link to refer to the details.

7.2.1 Sequence Number

7.2.9 Subtotal

7.2.10 Program Name

7.2.11 Total Steps

7.2.12 Handwritten Steps

7.2.13 Embedded Steps

7.2.14 Embedded Type

7.2.15 Update Date

7.2.18 Total

7.2.19 Average
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* The form image varies slightly depending on the language category.

Related items

7.1.1 Information of Embedded Member Steps (Form)

7.1.2 Information of Embedded Member Steps (List View)

7.1.4 Program Step Information (List View)

These sections provide output layout example (C/C++ form) for errors in the measurement target files.

7.1.4 Program Step Information (List View)
An output layout example (C/C++ List view) of program step information is shown below.

Click a link to refer to the details.

7.2.11 Total Steps

7.2.12 Handwritten Steps

7.2.13 Embedded Steps

7.2.14 Embedded Type

7.2.16 File Information

7.2.17 Folder Name

7.2.18 Total

7.2.19 Average
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* The List view image varies slightly depending on the language category.

By selecting a line and right-clicking, a pop-up menu providing the following operations is displayed.

- Display/Hide the following items (depending on the language type of measurement)

File Information/SQL Steps/SQL Ratio/Comment Steps/Comment Ratio/Embedded Type/Folder Name

- Copy data to the clipboard in CSV format

Related items

7.1.1 Information of Embedded Member Steps (Form)

7.1.2 Information of Embedded Member Steps (List View)

7.1.3 Program Step Information (Form)

These sections provide output layout example (C/C++ List view) for errors in the measurement target files.

7.1.5 Program Step Information (Variation Measurement)
An output layout example (Java) of program step information from variation measurement is shown below.

Click a link to refer to the details.

[When measuring valid lines only]

7.2.16 File Information

7.2.17 Folder Name

7.2.18 Total

7.2.19 Average

7.2.20 Valid Steps (Variation Measurement)

7.2.22 Total Steps (Variation Measurement)

[When measuring valid lines and comment lines]

7.2.16 File Information

7.2.17 Folder Name

7.2.18 Total

7.2.19 Average

7.2.20 Valid Steps (Variation Measurement)

7.2.21 Comment Steps (Variation Measurement)

7.2.22 Total Steps (Variation Measurement)
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By selecting a line and right-clicking, a pop-up menu providing the following operations is displayed.

- Display/Hide the following items (depending on the language type of measurement)

File Information/Folder Name

- Copy data to the clipboard in CSV format

7.2 Description of Measurement Output Items
This section explains measurement output items.

7.2.1 Sequence Number

Output Item Description

Sequence Number The sequence number for a source/include file (library file)

7.2.2 Embedded Member Names

Output Item Description

Embedded Member Name The include (library) file name

The length of the file name that can be output varies depending on the language category and the form options (output of SQL steps, output
of the date of the file). The rest of the file name that exceeds the maximum length is not output.

7.2.3 Breakdown of Steps
The breakdown of steps shows the number of measured steps of embedded members.

Output Item Description

Valid Steps excluding comments

Validity Ratio The ratio of valid steps to total steps (*1)

SQL Embedded SQL Steps

SQL Ratio The ratio of SQL to valid steps

ETC Valid steps excluding SQL

ETC Ratio The ratio of ETC to valid steps (*1)

Comment Comment steps

Comment Ratio The ratio of comments to total steps

Blank Blank steps

Total The total number of valid steps and comment steps
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*1: Not output in the list view mode.

7.2.4 Location
 

Output Item Description

Location The location where the library is expanded (not measured in C)

7.2.5 Cumulative Total Steps
 

Output Item Description

Cumulative Total Steps The cumulative total number of steps within the measurement target (the product of
the number of include [library] steps and the number of uses)

7.2.6 Number of Times Used
 

Output Item Description

Number of Times Used The number of uses within the measurement target

7.2.7 Used Program and Embedded Member Names
The used program name and the embedded member name are the library expanded program name and library name or the include expanded
program name and include name. As output information varies depending on the language category, refer to the following table for
confirmation.

[COBOL]

 
Output Item Description

Used Program and
Embedded Member Names

(P) The expanded program name
(C) The expanded library name
(I) The expanded include name

[C/C++]

 
Output Item Description

Used Program and
Embedded Member Names

(P) The expanded program name
(I) The expanded include name

The displayed file name can contain up to 12 characters. If the file name contains 13 or more characters, only the string up to the 12th
character is displayed.

7.2.8 Note Item
 

Output Item Description

Note Item The string set with the relevant [Step Measurement - Form] option

7.2.9 Subtotal
 

Output Item Description

Subtotal The total in units of folders (if [Output file path] is specified as a [Step Measurement
- Form] option)
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7.2.10 Program Name
 

Output Item Description

Program Name The target file

The length of the file name that can be output varies depending on the language category and the [Step Measurement - Form] options (output
of SQL steps, output of the date of the file). The rest of the file name that exceeds the maximum length is not output.

7.2.11 Total Steps
The total steps are the steps constituting one program. As the information output as total steps varies depending on the language category,
refer to the following table for confirmation.

[COBOL]

 
Output Item Description

Decl The number of valid steps in the declaration division (steps from the head of the
program to the line preceding PROCEDURE DIVISION)

Decl Ratio The ratio of declaration steps to total steps (*1)

SQL (Declaration Division) Number of embedded SQL steps in the declaration division

SQL Ratio (Declaration Division) The ratio of SQL to declaration steps

ETC (Declaration Division) Number of declaration steps, excluding SQL

ETC Ratio (Declaration Division) The ratio of ETC to declaration steps (*1)

Execution Number of valid steps in the execution division (steps following PROCEDURE
DIVISION)

Execution Ratio The ratio of execution steps to total steps (*1)

SQL (Execution Division) Number of embedded SQL steps in the execution division

SQL Ratio (Execution Division) The ratio of SQL to execution steps

ETC (Execution Division) Number of execution steps, excluding SQL

ETC Ratio (Execution Division) The ratio of ETC to execution steps (*1)

Cmnt Comment steps

Cmnt Ratio The ratio of comments to total steps

Blank Lines Blank steps

Sum The total number of declaration division steps, execution division steps, and comment
steps

[C/C++]

 
Output Item Description

Valid Steps excluding comments

Validity Ratio The ratio of valid steps to total steps (*1)

SQL Embedded SQL Steps

SQL Ratio The ratio of SQL to valid steps

ETC Valid steps excluding SQL

ETC Ratio The ratio of ETC to valid steps (*1)

Cmnt Comment steps

Cmnt Ratio The ratio of comments to total steps
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Output Item Description

Blank Lines Blank steps

Sum The total number of valid steps and comment steps

[Java, Auto-generated Java Source]

 
Output Item Description

Valid Steps excluding comments

Validity Ratio The ratio of valid steps to total steps (*1)

SQL Embedded SQL Steps

SQL Ratio The ratio of SQL to valid steps

ETC (Valid Lines) Valid steps excluding SQL

ETC Ratio (Valid Lines) The ratio of ETC to valid steps (*1)

Cmnt Comment steps

Cmnt Ratio The ratio of comments to total steps

Javadoc Number of Javadoc steps

Javadoc Ratio The ratio of Javadoc to comment steps

ETC (Comment Lines) Number of comment steps, excluding Javadoc

ETC Ratio (Comment Lines) The ratio of ETC to comment steps (*1)

Blank Lines Blank steps

Sum The total number of valid steps and comment steps

[IDL]

 
Output Item Description

Valid Steps excluding comments

Validity Ratio The ratio of valid steps to total steps (*1)

Cmnt Comment steps

Cmnt Ratio The ratio of comments to total steps

Blank Lines Blank steps

Sum The total number of valid steps and comment steps

[HTML/JSP/JS/CSS]

 
Output Item Description

Valid Steps excluding comments

Validity Ratio The ratio of valid steps to total steps (*1)

Cmnt Comment steps

Cmnt Ratio The ratio of comments to total steps

Blank Lines Blank steps

Sum The total number of valid steps and comment steps

[.NET (ASP/C#/VB)/HTML/JS/CSS]
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Output Item Description

Valid Steps excluding comments

Validity Ratio The ratio of valid steps to total steps (*1)

Cmnt Comment steps

Cmnt Ratio The ratio of comments to total steps

Blank Lines Blank steps

Sum The total number of valid steps and comment steps

[VB 6.0]

 
Output Item Description

Valid Steps excluding comments

Validity Ratio The ratio of valid steps to total steps (*1)

Cmnt Comment steps

Cmnt Ratio The ratio of comments to total steps

Blank Lines Blank steps

Sum The total number of valid steps and comment steps

[TEXT]

 
Output Item Description

Valid Steps excluding comments

Validity Ratio The ratio of valid steps to total steps (*1)

Cmnt Comment steps

Cmnt Ratio The ratio of comments to total steps

Blank Lines Blank steps

Sum The total number of valid steps and comment steps

*1: Not output in the list view mode.

7.2.12 Handwritten Steps
Handwritten steps are the steps excluding include files/copy library steps or steps in the handwritten division. As the information counted
as handwritten steps varies depending on the language category, refer to the following table for confirmation.

 
Language Category Description

COBOL Number of steps, excluding libraries

C/C++ Number of steps, excluding include files

Java Not output

IDL Not output

Auto-generated Java Source Steps in the handwritten division

HTML/JSP/JS/CSS Not output

.NET (ASP/C#/VB)/HTML/JS/CSS Not output

Visual Basic 6.0 Steps in the handwritten division

TEXT Not output
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* For details on the formats, refer to the Total Steps section.

7.2.13 Embedded Steps
Embedded steps are include files/libraries/auto-generation steps. As the information counted as embedded steps varies depending on the
language category, refer to the following table for confirmation.

 
Language Category Description

Auto-detection Output depending on the language category of the measurement target file

COBOL Number of library steps (*1)

C/C++ Number of include file steps (*1)

Java Not output

IDL Not output

Auto-generated Java Source Auto-generation steps (*2)

HTML/JSP/JS/CSS Not output

.NET (ASP/C#/VB)/HTML/JS/CSS Not output

Visual Basic 6.0 Auto-generation steps (*2)

TEXT Not output

* For details on the formats, refer to the Total Steps section.

*1: Information of embedded member steps (form and list view) can be output.

*2: Information of embedded member steps (form or list view) cannot be output.

7.2.14 Embedded Type
Output by embedded type is the total number of embedded member steps by copy library call type or by include file call type. As output
information varies depending on the language category, refer to the following table for confirmation.

[COBOL]

 
Output Item Description

C (COPY) The total number of steps of members (copy libraries) embedded via COPY phrase
calling

C Ratio The ratio of C (COPY) to embedded steps (*1)

I (INC) The total number of steps of members (copy libraries) embedded via INCLUDE
phrase calling

I Ratio The ratio of I (INC) to embedded steps (*1)

[C/C++]

 
Output Item Description

I (inc) The total number of steps of members (include files) embedded via include calling

I Ratio The ratio of I (inc) to embedded steps (*1)

R (rc) The total number of steps of members (include files) embedded via rcinclude calling

R Ratio The ratio of R (rc) to embedded steps (*1)

* Not output in the case of [Java], [IDL], [auto-generated Java source], [HTML/JSP/JS/CSS], [.NET (ASP/C#/VB)/HTML/JS/CSS], or
[TEXT].

*1: Not output in the list view mode.
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7.2.15 Update Date
 

Output Item Description

Update Date The update date of the target file. (If [Output the update date of the file] is specified as
a [Step Measurement - Form] option)

The display format with update is different according to the format of the region and
the language of OS setting.

When [Japanese (Japan)] is selected, it displays it by [yyyy/MM/dd HH:mm:ss].

It displays it by [MM/dd/yyyy HH:mm:ss] when selecting it excluding [Japanese
(Japan)].

7.2.16 File Information
 

Output Item Description

File Name Target File Name

Type The language name of the target file
For details, refer to the note section of [New Measurement]

Size The logical size of the target file

Update Date The update date of the target file

7.2.17 Folder Name
 

Output Item Description

Folder Name Target file folder name

7.2.18 Total
 

Output Item Description

Total The total number of all measurement target assets

7.2.19 Average
 

Output Item Description

Average The value derived from the total number of all measurement target assets averaged by
the number of measurements

7.2.20 Valid Steps (Variation Measurement)
Valid steps of old and new assets are output for each item as follows.

 
Output Item Description

Insertion Number of valid steps judged as "inserted" in the new asset

Variation Number of valid steps judged as "modified" in the new asset
(The total number of valid steps from pairs judged as "modified" in the old and new assets*)

Deletion Number of valid steps judged as "deleted" in the new asset

All Old Number of valid steps in all of the old assets

All New Number of valid steps in all of the new assets
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* Refer to the measurement examples of 4.2 Variation Measurement Criteria.

7.2.21 Comment Steps (Variation Measurement)
Comment steps of old and new assets are output for each item as follows.

 
Output Item Description

Insertion Number of comment steps judged as "inserted" in the new asset

Variation Number of comment steps judged as "modified" in the new asset
(The total number of comment steps from pairs judged as "modified" in the old and new assets*)

Deletion Number of comment steps judged as "deleted" in the old asset

All Old Number of comment steps in all of the old assets

All New Number of comment steps in all of the new assets

* Refer to the measurement examples of 4.2 Variation Measurement Criteria.

7.2.22 Total Steps (Variation Measurement)
Total number of comment steps of old and new assets are output.

 
Output Item Description

Old Total number of steps in the old assets

New Total number of steps in the new assets

* Note that if "Valid lines only" (default) is selected in 5.11.8 [Measure Variation - Measure] Option Settings, the total steps are equal to
the valid steps. * In addition, depending on the other selected measurement options, measurement values vary. For example, blank lines are
also included in the total steps as comment lines by default, but if [Measure blank lines] is not selected in 5.11.8 [Measure Variation -
Measure] Option Settings, blank lines are not counted as steps.

7.3 Measurement Error Output Examples
This section provides measurement error output examples.

7.3.1 Information of Embedded Member Steps (Form)
An output layout example (C/C++ form) for an error in the measurement target file is shown below.

 
Output Item Output Method

File Update Date Not output if there is an error in the measurement target file.

Steps Output as a 10-digit "*" string if there is an error in the measurement target file.
(No. 2 example)

Ratio Output as a 3-digit "*" string if there is an error in the measurement target file. (No.
2 example)

Total Not added if there is an error in the measurement target file.

Average Not counted if there is an error in the measurement target file.
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* The form image varies slightly depending on the language category.

* SQL steps and SQL ratio are not output.

Related items

7.1.1 Information of Embedded Member Steps (Form)

7.1.2 Information of Embedded Member Steps (List View)

7.1.3 Program Step Information (Form)

7.1.4 Program Step Information (List View)

7.3.2 Information of Embedded Member Steps (List View)
An output layout example (C/C++ List view) for an error in the measurement target file is shown below.

 
Output Item Output Method

File Size Output as 0 if there is an error in the measurement target file.

File Update Date Not output if there is an error in the measurement target file.

Steps Output as a 10-digit "*" string if there is an error in the measurement target file.
(The second line in the example)
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Output Item Output Method

Ratio Output as a 4-digit "*" string if there is an error in the measurement target file. (The
second line in the example)

Total Not added if there is an error in the measurement target file.

Average Not counted if there is an error in the measurement target file.

* The List view image varies slightly depending on the language category. 
* SQL steps and SQL ratio are not output. 
* The cell width of the file size will be wider than the exact width.

Related items

7.1.1 Information of Embedded Member Steps (Form)

7.1.2 Information of Embedded Member Steps (List View)

7.1.3 Program Step Information (Form)

7.1.4 Program Step Information (List View)

7.3.3 Program Step Information (Form)
An output layout example (C/C++ form) for an error in the measurement target file is shown below.

 
Output Item Output Method

File Update Date Not output if there is an error in the measurement target file.

Steps Output as a 10-digit "*" string if there is an error in the measurement target file.
(No. 2 example)
"*" is added as a prefix to steps if there is an error in the embedded member. (No.
3 example)

Ratio Output as a 3-digit "*" string if there is an error in the measurement target file. (No.
2 example)
"*" is added as a prefix to the ratio if there is an error in the embedded member.
(No. 3 example)

Total Not added if there is an error in the measurement target file.
Added even if there is an error in the embedded member.

Average Not counted if there is an error in the measurement target file.
Counted even if there is an error in the embedded member.
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* The form image varies slightly depending on the language category.
* SQL steps and SQL ratio are not output.

Related items

7.1.1 Information of Embedded Member Steps (Form)

7.1.2 Information of Embedded Member Steps (List View)

7.1.3 Program Step Information (Form)

7.1.4 Program Step Information (List View)

7.3.4 Program Step Information (List View)
An output layout example (C/C++ List view) for an error in the measurement target file is shown below.

 
Output Item Output Method

File Size Output as 0 if there is an error in the measurement target file.

File Update Date Not output if there is an error in the measurement target file.

Steps Output as a 10-digit "*" string if there is an error in the measurement target file.
(The second line in the example)
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Output Item Output Method

"*" is added as a prefix to steps if there is an error in the embedded member. (The
third line in the example)

Ratio Output as a 4-digit "*" string if there is an error in the measurement target file. (The
second line in the example)
"*" is added as a prefix to the ratio if there is an error in the embedded member.
(The third line in the example)

Total Not added if there is an error in the measurement target file.
Added even if there is an error in the embedded member.

Average Not counted if there is an error in the measurement target file.
Counted even if there is an error in the embedded member.

* The List view image varies slightly depending on the language category.

* SQL steps and SQL ratio are not displayed.

* The cell width of the file size will be wider than the exact width.

Related items

7.1.1 Information of Embedded Member Steps (Form)

7.1.2 Information of Embedded Member Steps (List View)

7.1.3 Program Step Information (Form)

7.1.4 Program Step Information (List View)
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Chapter 8 Supplementary Notes
This chapter provides supplementary information on MF-STEPCOUNTER.

8.1 Advisory Notes
The precautions to be observed when using SIMPLIA MF-STEPCOUNTER are as follows.

- SIMPLIA MF-STEPCOUNTER cannot handle 260-byte or longer paths.

- Source files larger than 4 GB cannot be measured.

- Search path specification supports up to 10 paths. It is not possible to specify 11 or more paths.

- If the [Measure embedded members] measurement option is specified, and if embedded members are specified as measurement target
files, measurement cannot be performed properly.

- Embedded members can be nested using up to 8 levels of hierarchy. Nested levels deeper than this are ignored in measurement.

- The measurement target asset is based on the assumption that it has been described correctly according to the syntax of each language.

- The paper size for printing is fixed as A4 portrait. If a format other than this is specified, the results of printing are not guaranteed.

- The comment column of a form can contain up to 15 Japanese characters or up to 30 one-byte alphanumeric characters. Characters
exceeding this limit cannot be specified.

- Files specified by the embedded SQL include (EXEC SQL INCLUDE, $include) statements are not regarded as the targets of embedded
members.

- COPY libraries and include files (such as #include) in embedded SQL are not regarded as the targets of embedded members.

- Average and ratio calculations are all rounded off to whole numbers.

- As an effect of rounding errors, if the number of target assets or the asset size is particularly small, value inconsistencies or abnormal
values (such as a value exceeding 100%) may be displayed.

- The form mode and the list view mode use differing methods for calculating average values, so the values may not be consistent.

- As SIMPLIA MF-STEPCOUNTER uses the following font, this font must be installed in the Windows system.

- MS Mincho

- The display resolution should be 640 x 480 or higher.

- For the reading of an identifier file (AJD file), use a file output from the [Step Measurement - Auto-detection (Java)] options dialog box
or [Step Measurement - Auto-detection (VB 6.0)] options dialog box.

- For the reading of an extension file (AJD file), use a file output from the [Common - Extension] options dialog box.

- For measurement target assets, specify files of the language category with the extension specified in the [Common - Extension] options
dialog box.

- The character code of following output files has been changed from V60L12.

 
File Type V60L11 or earlier V60L12 or later

CSV (measurement results) file ShiftJIS UTF-8 with BOM (Byte Order Mark)

Measurement results log file ShiftJIS UCS2 little endian with BOM (Byte Order Mark)

Identifier file ShiftJIS UCS2 little endian without BOM (Byte Order Mark)

Extension file ShiftJIS UCS2 little endian without BOM (Byte Order Mark)

Note that if you have used V60L11 or earlier so far and replace it with V60L12 or later this time, you have to change the file name of
measurement results log file. Otherwise, you will not be able to browse the log data due to newly appended data written in different character
code.
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About Step Measurement

- About embedded member folder searches

In addition to the folders specified with the [Step Measurement - Search Path] options, the folders of the assets are also searched. In the
absence of [Step Measurement - Search Path] option specification, only the folders of assets are searched.

The folders specified with the [Step Measurement - Search Path] option are given priority when performing searches.

- If [Measure embedded members] is checked as a [Step Measurement - Measure] option, measurement requires more time as it becomes
more complex due to elements such as the number of embedded member calls and the depth of configuration and hierarchies. It is
recommended to uncheck this option unless it is necessary.

- If [Auto-generated Java Source] is selected as the measurement language category, source containing no pair of automatic identifiers
as specified in the Auto-detect Java option settings is measured entirely as auto-generated source (embedded steps).

- If [Visual Basic 6.0] is selected as the measurement language category, source that contains no pair of automatic identifiers specified
in the Auto-detect VB 6.0 option settings is measured entirely as handwritten steps.

- In the step measurement, when the byte number of one line of the measurement assets exceeds 131,072 bytes, the measurement result
is not guaranteed.

 
About Variation Measurement

- The following measurements that can be performed in step measurement have the following restrictions in variation measurement.

- COBOL and C/C++ embedded member expanded measurement is not possible.

- Embedded SQL in COBOL and C/C++ cannot be measured separately (It is included in valid/comment steps).

- COBOL declaration divisions and execution divisions cannot be measured separately.

- Measurement by COBOL program ID is not possible. Measurement is performed by file unit.

- Old and new files with different names can be compared if the [File] specification method is selected as the asset specification method,
but only files with the same names are compared if the [Folder] specification method is selected. To include subfolders in the
measurement, the subfolders must also have the same name.

- Note that total steps vary depending on the [Measure Variation - Measure] Options specified.
Example: In [Valid lines only] measurement, total steps are equal to the steps of valid lines only.

- In the variation measurement, the number of actual lines of the measurement asset and the number of steps of measurement results might
be different because when the size of one line of the measurement asset exceeds 1,024 bytes, the value that is divided by 1,024 and
rounded up is taken as the number of steps.

 
About Forms

- The length of the file name that can be output varies depending on the language category and the form options (output of SQL steps,
output of the date of the file). The rest of the file name that exceeds the maximum length is not output.

- The number of maximum display columns in form mode is 8. Therefore, when there is a value that exceeds 8 columns in the
measurement results, the portion will be shown by "*" and the message that a part of the measurement results cannot be shown will be
displayed.
The part of "*" can be seen by generating the CSV file.

 
About List View

- About the minimum value of comment ratio

The compared values are the data for display. As display data is rounded off to whole numbers, values not originally regarded as targets for
red display are displayed in red.

Example: If the minimum value of comment ratio is set to 20%, the following value is also displayed in red.

20% (It is actually 20.1% but is displayed as 20% on screen, as it has been rounded off)

* If the language category of the measurement target asset is [TEXT], the setting is disabled. (The minimum value of comment ratio is
always displayed in black.)

- 94 -



- About file category judgment in Java

If multiple class/interface definitions are present in one file, the first class/interface is used for judgment.

- The list view cannot be printed. After performing CSV file output, edit and print the results using an application such as Excel or other
spreadsheet software.

- The sorting order (ascending or descending) specified on each column is initialized when the list view dialog is closed. In addition, when
program information and embedded member information are both displayed, corresponding items are not synchronized.

- The display folder setting is initialized when the list view dialog is closed.

- The comment ratio is derived from "100% - [Declaration Division Valid Steps %] - [Execution Division Valid Steps %]" and may not
be consistent with the comment ratio calculated from comment steps and total steps.

- The number of maximum display columns in list view mode is 8. Therefore, when there is a value that exceeds 8 columns in the
measurement results, the portion will be shown by "*" and the message that a part of the measurement results cannot be shown will be
displayed.
The part of "*" can be seen by generating the CSV file.

 
About Measurement Target Assets

- If the measurement target asset contains a linefeed code other than "CR+LF", measurement results are not guaranteed.

- As source files described in Shift JIS or UNICODE (UTF-8 or UCS2 [Big Endian or Little Endian] with BOM [Byte Order Mark]) are
measurement targets, measurement results from source files described in other character codes are not guaranteed.

- In variation measurement, up to 30,000 steps are supported per file. However, when measuring valid lines only, up to 30,000 valid steps
are supported (The total number of steps can exceed 30,000).

- Depending on the character code, the size of one line that can be measured are as follows.

 
Character code Size

ShiftJIS 131,072 bytes (including CR/LF)

UTF-8 131,072 bytes (including CR/LF)

UCS2 little endian with BOM (Byte Order Mark) 131,072 bytes (including CR/LF)

UCS2 big endian with BOM(Byte Order Mark)
The size of one line when converting UTF-8 is 131,072 bytes
(including CR/LF)

 
About Measurement of COBOL

- In the source file, the start of the identification division (IDENTIFICATION DIVISION) and the start of the procedure division
(PROCEDURE DIVISION) must be described. If either of or both of these are not described or are described in a COPY phrase library
file, measurement cannot be performed properly.

- The COBOL free source format is not supported.

- If a program file or COPY phrase library file contains tabs across the sequence number area (1st to 6th columns), the indicator area (7th
column), or the A area (8th to 12th columns), measurement is not performed properly.

- If measurement target assets are specified by folder unit when embedded members are to be measured, and if embedded members are
located in the specified folder or in a subfolder of the specified folder, embedded members are also measured as program steps
regardless of whether those folders are specified in the search path. Place embedded members in a different location from the specified
folder.

 
About Measurement of C/C++

- If #include and rcinclude are described in the continuation lines of string constants they are recognized as embedded commands.

Example: In the following case, "AAA.H\" is recognized as an embedded member name and searched as a measurement target.

strcpy(szBuf,"ABCDEFG \
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#include \"AAA.H\"");

 
About Measurement of Auto-generated Java Source & Visual Basic 6.0

- It is not possible to register more than 100 extensions.

- In Auto-generated Java Source or Visual Basic 6.0 measurement, the following extensions are exempt from judgment.

- Start identifiers and end identifiers nested within another start identifier and end identifier pair

- Invalid end identifiers that are not properly combined with start identifiers

- End identifiers whose corresponding start identifiers are missing

- The identifiers pre-defined as standard for VB6.0 are not based on the published specifications from Microsoft. Therefore, edit or add
identifiers if measurement is inaccurate.

- The Auto-detect VB 6.0 option provided as standard has the following restriction.

- It has been confirmed that some *.cls files contain lines with "Attribute VB_Ext_KEY" attributes even after a line of the "Attribute
VB_Exposed" attribute. These lines are measured as handwritten lines.

 
About Measurement of ASP

- If a linefeed is inserted in the middle of a <SCRIPT> tag in which "language" and "type" attributes are described, an incorrect script
attribute will be used in measurement.

 
About Character Code

- If an incorrect character code is specified, measurement results are not guaranteed.

- If assets of different character codes are measured at the same time, the measurement results of files whose character code is not the
specified one are not guaranteed.
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Chapter 9 Messages
This chapter explains the details of errors output in MF-STEPCOUNTER.

9.1 Message List
- STP-001 Failed to open the intermediate file,[file name].

- STP-002 Failed to write to the intermediate file,[file name].

- STP-003 Failed to output the results.

- STP-004 Failed to open the measurement results file,[file name].

- STP-005 Failed to write to the measurement results file,[file name].

- STP-006 The format of the measurement result file,[file name], is incorrect.

- STP-007 Error in the file format of the measurement target file,[file name].

- STP-008 Failed to open the measurement target file,[file name].

- STP-009 The measurement target file,[file name], contains an invalid comment statement (Line [number]).

- STP-010 The measurement target file,[file name], contains an invalid SQL statement (Line [number]).

- STP-011 The file, [file name], has more than 30,000 lines.

- STP-012 There are [number] measurement errors. Check the error file.

- STP-013 Unable to output. There are too many lines of code.

- STP-014 Failed to open the CSV file,[file name].

- STP-015 Failed to write to the CSV file,[file name].

- STP-016 Error in page specification.

- STP-017 There is an error in the number of copies specified.

- STP-018 The printer cannot be used.

- STP-019 Unable to print, there is insufficient disk space for spooling.

- STP-020 Unable to print, there is insufficient memory for spooling.

- STP-021 There is an error in the report type specification.

- STP-022 The results have not been saved.Save the results now?

- STP-023 There is insufficient memory to display the message.

- STP-024 Failed to obtain the TEMP folder.

- STP-025 Opening of the assets folder name file failed.

- STP-026 Opening of the assets file name file failed.

- STP-027 The specified folder does not exist.

- STP-028 The specified string is not a folder name.

- STP-029 A folder with the same name already exists.

- STP-030 A lower hierarchy folder of the specified folder already exists.

- STP-031 A higher layer folder of the specified folder already exists.

- STP-032 There are no folders registered.

- STP-033 There are no files registered.
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- STP-034 The result file format is not supported.

- STP-035 More than the maximum of number cannot be specified for the identification string.

- STP-036 The identification string already exists.

- STP-037 The combination of the identifiers is invalid.FILE:[file name] LINE:No.[number]

- STP-038 Reading of the identifier file failed.File:[file name].

- STP-039 Writing to the identifier file failed.File:[file name].

- STP-040 The contents will be erased and identifiers obtained from the file.Are you sure?

- STP-041 The tag (Starting at line [number]) in the measurement target file, [file name], is incorrect.

- STP-042 An old result file was read.When measuring by program ID, please review the option settings.

- STP-043 An old result file was read.When measuring the header file (*.h) as program step information, please review the option
settings.

- STP-044 An input/output error occurred during code conversion of the measurement target file,[file name].

- STP-045 The contents will be erased and extensions obtained from the file.Are you sure?

- STP-046 Reading of the extension file failed.FILE:[file name]

- STP-047 Writing to the extension file failed.FILE:[file name]

- STP-048 More than 10 extensions cannot be specified in the extension string.

- STP-049 Please specify the extension string using between 1 and 10 characters.

- STP-050 There is an invalid character in the extension.

- STP-051 Japanese characters (2-bytes) cannot be specified.

- STP-052 The extension already exists.

- STP-053 It is already specified in the same language category record.

- STP-054 The development language of the file,[file name], cannot be identified.

- STP-055 Multiple starts are prohibited.

- STP-056 Use in the trial version is not possible.

- STP-057 Unable to find the file.

- STP-058 Error in the number of files.

- STP-059 Please specify a folder name.

- STP-060 Creation of header control failed.

- STP-061 Creation of list control failed.

- STP-062 Failed to secure memory.

- STP-063 Select one line to change.

- STP-064 The same file name already exists.

- STP-065 The contents will be erased and extensions initialized. Are you sure?

- STP-066 Please specify the language type.

- STP-067 The size of measurement target file ,[file name], exceeds the limit.

9.2 Message Details
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STP-001 Failed to open the intermediate file,[file name].

Opening of the intermediate file used internally by MF-STEPCOUNTER failed. Intermediate files are all stored in the folder named
[Folder set in the TEMP environment variable\mfstptmp_32] and deleted together with the mfstptmp_32 folder when MF-
STEPCOUNTER is closed.

 
Message output destination

Display, Error File

 
Assumed Causes

1. Intermediate files were deleted during the startup of MF-STEPCOUNTER.

2. Media defect.

 
Corrective Actions

Check whether the folder (drive) set in the "TEMP" environment variable is accessible.

 
STP-002 Failed to write to the intermediate file,[file name].

Writing to the intermediate file used internally by MF-STEPCOUNTER failed. Intermediate files are all stored in the folder named
[Folder set in the TEMP environment variable\mfstptmp_32] and deleted together with the mfstptmp_32 folder when MF-
STEPCOUNTER is closed.

 
Message output destination

Display, Error File

 
Assumed Causes

1. An exclusion error in the intermediate file.

2. The folder (drive) set in the "TEMP" environment variable has insufficient space.

3. Media defect.

 
Corrective Actions

Check whether the folder (drive) set in the "TEMP" environment variable is accessible.

 
STP-003 Failed to output the results.

An error occurred while outputting the document to the screen or printer.

 
Message output destination

Display

 
Assumed Causes

1. The intermediate file was not created properly. (An error occurred before opening or writing to the intermediate file.)

2. When reading, the contents of the specified measurement results file are incorrect.

 
Corrective Actions

When reading, specify the measurement results file with the correct contents.

 
STP-004 Failed to open the measurement results file,[file name].

Opening of the specified measurement results file failed.

 
Message output destination

Display, Error File
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Assumed Causes

1. When reading, the specified measurement results file does not exist. (The name is incorrect.)

2. Media defect.

 
Corrective Actions

Check whether the storage folder for the measurement results file is accessible. When reading, specify the correct measurement results
file name.

 
STP-005 Failed to write to the measurement results file,[file name].

Writing to the specified measurement results file failed.

 
Message output destination

Display

 
Assumed Causes

1. An exclusion error in the measurement results file.

2. The storage folder (drive) for the measurement results file has insufficient space.

3. Media defect.

 
Corrective Actions

Check whether the storage folder for the measurement results file is accessible.

 
STP-006 The format of the measurement result file,[file name], is incorrect.

There is an error in the contents of the specified measurement results file.

 
Message output destination

Display

 
Assumed Causes

1. A file other than a measurement results file was specified and read.

2. The measurement results file is corrupt.

3. Media defect.

 
Corrective Actions

Specify the measurement results file with the correct contents.

 
STP-007 Error in the file format of the measurement target file,[file name].

There is an error in the contents of the measurement target source file.

 
Message output destination

Display, Error File

 
Assumed Causes

1. A file other than a text file was specified as the measurement target.

2. The specified character code and the measurement target file code are inconsistent.

 
Corrective Actions

Files other than text files cannot be specified as measurement targets. Specify the correct source files as measurement targets.
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Additionally, when an incorrect code is specified, measurement results are not guaranteed. Ensure that the character code and the source
file code are consistent.

 
STP-008 Failed to open the measurement target file,[file name].

Opening of the measurement target source file failed.

 
Message output destination

Display, Error File

 
Assumed Causes

1. The specified source file does not exist.

2. Media defect.

 
Corrective Actions

Confirm that the measurement target source file exists.

 
STP-009 The measurement target file,[file name], contains an invalid comment statement (Line [number]).

There is an error in a comment in the measurement target source file. (This is reported when C/C++, Java, Auto-generated Java Source,
or IDL files are measured.)

 
Message output destination

Display, Error File

 
Assumed Causes

The comment end symbol (*/) corresponding to a comment start symbol (/*) or a Javadoc comment start symbol (/**) was not found
before the end of a measurement target source file was reached.

 
Corrective Actions

Check the comment statements in the measurement target source file.

 
STP-010 The measurement target file,[file name], contains an invalid SQL statement (Line [number]).

There is an error in an embedded SQL statement in the measurement target source file. (This is reported only when the SQL measurement
option is specified.)

 
Message output destination

Display, Error File

 
Assumed Causes

The embedded SQL end symbol (;, END-EXEC, etc.) corresponding to an embedded SQL start symbol ($, EXEC SQL, etc.) was not
found before the end of a measurement target source file was reached.

 
Corrective Actions

Check the SQL statements in the measurement target source file.

 
STP-011 The file, [file name], has more than 30,000 lines.

The target file has more than 30,000 steps.

 
Message output destination

Display, Error File

 
Assumed Causes

Variation measurement measured a source file that has more than 30,000 steps.
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However, if [Valid lines only] is selected in the [Measure Variation - Measure] Options Setting dialog box, this message is output if a
source file that has more than 30,000 valid lines, excluding comment lines, is measured.

 
Corrective Actions

Check the validity of comments with deleted/modified/inserted steps, which have been indicated with "****".

 
STP-012 There are [number] measurement errors. Check the error file.

There are errors in comment statements or embedded SQL statements in the measurement target source files. Check the error file (Folder
set in the "TEMP" environment variable\MF_STP32.ERR).

 
Message output destination

Display

 
Assumed Causes

There are errors in the comment statements, embedded SQL statements, or other errors in measurement target source files.

 
Corrective Actions

Check the error file and correct the source files with errors.

 
STP-013 Unable to output. There are too many lines of code.

The size or the number of steps in the measurement target source file has exceeded the limit of MF-STEPCOUNTER.

Measurement results for size or steps are output as "**********" and the percentage is output as "0%".

 
Message output destination

Display

 
Assumed Causes

File size in bytes (including total size) or number of steps (including total steps and cumulative total steps) have exceeded 99,999,999.

 
Corrective Actions

Generate the CSV file and see it to know the value of the part of "**********".

 
STP-014 Failed to open the CSV file,[file name].

Opening of the file specified during CSV file creation failed.

 
Message output destination

Display

 
Assumed Causes

Media defect. (If the storage location is a floppy disk, no floppy disk has been inserted.)

 
Corrective Actions

Check whether the folder (drive) where the CSV file is saved is accessible.

 
STP-015 Failed to write to the CSV file,[file name].

Opening of the file specified during CSV file creation failed.

 
Message output destination

Display

 
Assumed Causes

1. An exclusion error in the CSV file.
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2. The folder (drive) where the CSV file is saved has insufficient space.

3. Media defect.

 
Corrective Actions

Check whether the folder (drive) where the CSV file is saved is accessible.

 
STP-016 Error in page specification.

Incorrect pages were specified in the Specify Page dialog box or the Specify Print Range dialog box from the Windows menu.

 
Message output destination

Display

 
Assumed Causes

1. The numbers of pages specified do not exist in the file created for measurement results.

2. A non-numerical character (including spaces and tabs) was specified.

 
Corrective Actions

Specify the correct page numbers.

 
STP-017 There is an error in the number of copies specified.

An incorrect number of copies was specified in the Specify Print Range dialog box.

 
Message output destination

Display

 
Assumed Causes

1. A value smaller than 0 was specified.

2. A non-numerical character (including spaces and tabs) was specified.

 
Corrective Actions

Specify the correct number of copies.

 
STP-018 The printer cannot be used.

The current printer is not ready for use.

 
Message output destination

Display

 
Assumed Causes

The default printer is not set.

 
Corrective Actions

Set the default printer from the control panel.

 
STP-019 Unable to print, there is insufficient disk space for spooling.

The print spool folder (folder set in the "TEMP" environment variable) has insufficient space and printing is not possible.

 
Message output destination

Display
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Assumed Causes

Insufficient space in the spool folder.

 
Corrective Actions

Specify a folder (drive) that has sufficient space in the "TEMP" environment variable.

 
STP-020 Unable to print, there is insufficient memory for spooling.

Memory is insufficient for print spooling and printing is not possible.

 
Message output destination

Display

 
Assumed Causes

Insufficient memory.

 
Corrective Actions

Data exceeding the memory limit cannot be printed.

 
STP-021 There is an error in the report type specification.

There is an error in the document type specification in the measurement options setting dialog box or in the printing dialog box.

 
Message output destination

Display

 
Assumed Causes

No document was specified (checked) for output or measurement.

 
Corrective Actions

At least one document must be specified as the output or measurement target. To cancel the settings in the dialog box, select [Cancel].

 
STP-022 The results have not been saved.Save the results now?

The current measurement results will be discarded. Are you sure?

 
Message output destination

Display

 
Assumed Causes

When unsaved measurement results were present in the dialog, one of the following operations was performed.

1. [New Measurement] was selected from the File menu.

2. [Read] was selected from the File menu.

3. [Exit MF-STEPCOUNTER] was selected from the menu.

4. Windows was shut down.

 
Corrective Actions

Select [Yes] to save the results or select [No] to discard them.

 
STP-023 There is insufficient memory to display the message.

There is insufficient memory to generate the message box.

 
Message output destination

Error File
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Assumed Causes

Insufficient memory

 
Corrective Actions

End other running applications if there are any.

 
STP-024 Failed to obtain the TEMP folder.

The folder name set in the "TEMP" environment variable could not be obtained.

 
Message output destination

Display

 
Assumed Causes

OS defect.

 
Corrective Actions

Check whether the folder (drive) set in the "TEMP" environment variable is accessible.

 
STP-025 Opening of the assets folder name file failed.

Opening of the intermediate file [Asset Folder Name File] used internally by MF-STEPCOUNTER failed. Intermediate files are all
stored in the folder named [Folder set in the TEMP environment variable\mfstptmp_32] and deleted together with the mfstptmp_32
folder when MF-STEPCOUNTER is closed.

 
Message output destination

Display

 
Assumed Causes

1. Intermediate files were deleted during the startup of MF-STEPCOUNTER.

2. Media defect.

 
Corrective Actions

Check whether the folder (drive) set in the "TEMP" environment variable is accessible.

 
STP-026 Opening of the assets file name file failed.

Opening of the intermediate file [Asset File Name File] used internally by MF-STEPCOUNTER failed. Intermediate files are all stored
in the folder named [Folder set in the TEMP environment variable\mfstptmp_32] and deleted together with the mfstptmp_32 folder
when MF-STEPCOUNTER is closed.

 
Message output destination

Display

 
Assumed Causes

1. Intermediate files were deleted during the startup of MF-STEPCOUNTER.

2. Media defect.

 
Corrective Actions

Check whether the folder (drive) set in the "TEMP" environment variable is accessible.

 
STP-027 The specified folder does not exist.

The specified folder does not exist.
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Message output destination

Display

 
Assumed Causes

A folder with the specified name does not exist.

 
Corrective Actions

Confirm the existence of the folder.

 
STP-028 The specified string is not a folder name.

The specified string is not a folder name.

 
Message output destination

Display

 
Assumed Causes

A file name was specified.

 
Corrective Actions

Confirm the folder.

 
STP-029 A folder with the same name already exists.

A folder with the same name already exists.

 
Message output destination

Display

 
Assumed Causes

A folder with the same name already exists.

 
Corrective Actions

Specify folders other than the folders that have already been registered.

 
STP-030 A lower hierarchy folder of the specified folder already exists.

A lower hierarchy folder of the specified folder already exists.

 
Message output destination

Display

 
Assumed Causes

The [Search in sub folders] measurement option for step measurement/variation measurement has been checked.

 
Corrective Actions

Delete the lower hierarchy folder or uncheck the [Search in sub folders] measurement option.

 
STP-031 A higher layer folder of the specified folder already exists.

A higher layer folder of the specified folder already exists.

 
Message output destination

Display
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Assumed Causes

The [Search in sub folders] measurement option for step measurement/variation measurement has been checked.

 
Corrective Actions

Delete the higher layer folder or uncheck the [Search in sub folders] measurement option.

 
STP-032 There are no folders registered.

There are no measurement target folders registered.

 
Message output destination

Display

 
Assumed Causes

No measurement target folders have been specified.

 
Corrective Actions

Specify measurement target folders.

 
STP-033 There are no files registered.

There are no measurement target files registered.

 
Message output destination

Display

 
Assumed Causes

No measurement target files have been specified.

 
Corrective Actions

Specify measurement target files.

 
STP-034 The result file format is not supported.

Unsupported results file format.

 
Message output destination

Display

 
Assumed Causes

1. Results file created by an unsupported version of MF-STEPCOUNTER.

2. The results file could not be found.

 
Corrective Actions

Check the specified file.

 
STP-035 More than the maximum of number cannot be specified for the identification string.

It is not possible to specify more than 100 identifiers to use for judging handwritten/auto-generation in auto-generated Java source and
Visual Basic 6.0 source files.

 
Message output destination

Display

 

- 107 -



Assumed Causes

This message is displayed if an attempt to specify more than 100 identifiers is made in the [Step Measurement - Auto-detection (Java)]
Options Dialog Box.

This message is displayed if an attempt to specify more than 100 identifiers is made in the [Step Measurement - Auto-detection (VB 6.0)]
Options Dialog Box.

 
Corrective Actions

Specify 100 or less identifiers.

 
STP-036 The identification string already exists.

The identifier already exists as an identifier used to judge handwritten/auto-generation in auto-generated Java source and Visual Basic
6.0 source files.

 
Message output destination

Display

 
Assumed Causes

The identifier specified as an additional registration in the [Step Measurement - Auto-detection (Java)] Options Dialog Box already
exists.

The identifier specified as an additional registration in the [Step Measurement - Auto-detection (VB6.0)] Options Dialog Box already
exists.

 
Corrective Actions

Check the registered identifiers.

 
STP-037 The combination of the identifiers is invalid.FILE:[file name] LINE:No.[number]

In auto-generated Java source or Visual Basic 6.0 measurement, identifier inconsistencies were detected in the source file.

 
Message output destination

Display, Error File

 
Assumed Causes

This message is displayed if [Display error for mismatched identifiers] is selected in the [Step Measurement - Auto-detection (Java)]
Options Dialog Box or the [Step Measurement - Auto-detection (VB6.0)] Options Dialog Box. The measurement target auto-generated
Java source or Visual Basic 6.0 source file may contain identifier inconsistencies.

1. There are start and end identifiers nested within a start and end identifier pair.

2. The combination of start and end identifiers is invalid.

3. There are end identifiers whose corresponding start identifiers could not be found.

4. There are no end identifiers that correspond to existing start identifiers.

 
Corrective Actions

Check measurement target assets (Auto-generated Java Source or Visual Basic 6.0 files) and modify the source file identifiers if
necessary.

 
STP-038 Reading of the identifier file failed.File:[file name]

Because the identifier file could not be read, identifiers could not be input.

 
Message output destination

Display
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Assumed Causes

One of the following errors may have occurred during reading of the identifier file when reading identifiers from the [Step Measurement
- Auto-detection (Java)] Options Dialog Box or the [Step Measurement - Auto-detection (VB 6.0)] Options Dialog Box.

1. An error in the contents of the identifier file

2. An exclusion error in the identifier file

3. An error in the case of selection of multiple AJD files

 
Corrective Actions

Check the identifier file to be read.

 
STP-039 Writing to the identifier file failed.File:[file name]

Because the identifier file could not be written to, identifiers could not be output.

 
Message output destination

Display

 
Assumed Causes

One of the following errors may have occurred during accessing of the identifier file when writing identifiers from the [Step
Measurement - Auto-detection (Java)] Options Dialog Box or the [Step Measurement - Auto-detection (VB 6.0)] Options Dialog Box.

1. An exclusion error in the identifier file

2. Insufficient space in the output destination folder for the identifier file

3. Media defect in the output destination folder for the identifier file

 
Corrective Actions

Check the identifier file to be written to and the output destination folder.

 
STP-040 The contents will be erased and identifiers obtained from the file.Are you sure?

In order to store identifiers in the identifier file, registered identifiers have been erased.

 
Message output destination

Display

 
Assumed Causes

This is a confirmation message displayed when reading identifiers from the [Step Measurement - Auto-detection (Java)] Options Dialog
Box or the [Step Measurement - Auto-detection (VB 6.0)] Options Dialog Box.

 
Corrective Actions

When erasing the registered identifiers and reading identifiers for the identifier file, continue processing.

 
STP-041 The tag (Starting at line [number]) in the measurement target file, [file name], is incorrect.

There is an error in a tag statement in a measurement target source file.

 
Message output destination

Display, Error File

 
Assumed Causes

An end tag to correspond to a start tag was not found before the end of the measurement target source file was reached.

 
Corrective Actions

Check tag statements in the measurement target source file.
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STP-042 An old result file was read.When measuring by program ID, please review the option settings.

Because the results file version is old, the [Measure by program ID] measurement option is disabled.

 
Message output destination

Display

 
Assumed Causes

An old version of the results file from measurement of COBOL was read.

 
Corrective Actions

The [Measure by program ID] measurement option is disabled.

To perform measurement by program ID, enable this option and measure all.

 
STP-043 An old result file was read.When measuring the header file (*.h) as program step information,
please review the option settings.

Because the results file version is old, the [Measure header files (*.h) when the folder is specified] measurement option is disabled.

 
Message output destination

Display

 
Assumed Causes

An old version of the results file from measurement of C/C++ was read.

 
Corrective Actions

The [Measure header files (*.h) when the folder is specified] measurement option has been disabled.

To also measure header files (*.h), enable this option and measure all.

 
STP-044 An input/output error occurred during code conversion of the measurement target file,[file
name].

An error occurred during character code conversion of a measurement target file.Confirm that the file is not corrupt or does not conflict
with restrictions.

 
Message output destination

Display, Error File

 
Assumed Causes

When measuring assets that conflict with restrictions of the target assets or when the measurement target assets are exclusively grabbing
by another application.

 
Corrective Actions

Include the -FORCE option to the start option to continue the measurement.

 
STP-045 The contents will be erased and extensions obtained from the file.Are you sure?

In order to store extensions in the extension file, registered extensions will be erased.

 
Message output destination

Display

 
Assumed Causes

This is a confirmation message displayed when reading extensions from the [Common - Extension] Options.
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Corrective Actions

When erasing the registered extensions and reading extensions for the extension file, continue processing.

 
STP-046 Reading of the extension file failed.FILE:[file name]

Because the extension file could not be read, extensions could not be input.

 
Message output destination

Display

 
Assumed Causes

One of the following errors may have occurred during the reading of the extension file when reading extensions from the [Common -
Extension] Options.

1. An error in the contents of the extension file

2. An exclusion error in the extension file

3. An error in the case of selection of multiple AJD files

 
Corrective Actions

Check the extension file to be read.

 
STP-047 Writing to the extension file failed.FILE:[file name]

Because the extension file could not be written to, extensions could not be output.

 
Message output destination

Display

 
Assumed Causes

One of the following errors may have occurred during accessing of the extension file when writing extensions from the [Common -
Extension] Options.

1. An exclusion error in the extension file

2. Insufficient space in the out destination folder for the extension file

3. Media defect in the out destination folder for the extension file

 
Corrective Actions

Check the extension file to be written to and the output destination folder.

 
STP-048 More than 10 extensions cannot be specified in the extension string.

Up to 10 additional extensions can be specified for each language type/language category.

 
Message output destination

Display

 
Assumed Causes

More than 10 extensions were added in the Extension column in the extension specification dialog.

 
Corrective Actions

Specify 10 or less extensions.

 
STP-049 Please specify the extension string using between 1 and 10 characters.

Please specify the extension string using between 1 and 10 characters.
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Message output destination

Display

 
Assumed Causes

An extension with more than 10 characters was specified in the extension string.

 
Corrective Actions

Specify extension strings using 10 or less characters.

 
STP-050 There is an invalid character in the extension.

There is an invalid character in the extension.

 
Message output destination

Display

 
Assumed Causes

The extension string contains one or more of the following characters.

< > / \ | : " * ?

 
Corrective Actions

Check for invalid characters and modify the extension string.

 
STP-051 Japanese characters (2-bytes) cannot be specified.

Japanese characters (2-bytes) cannot be specified.

 
Message output destination

Display

 
Assumed Causes

The extension string contains Japanese or other two-byte characters.

 
Corrective Actions

Erase Japanese or other two-byte characters from the extension string.

 
STP-052 The extension already exists.

The extension already exists.

 
Message output destination

Display

 
Assumed Causes

The extension string contains an overlapping extension.

 
Corrective Actions

Erase the overlapping extension from the extension string.

 
STP-053 It is already specified in the same language category record.

It is already specified in the same language category record.

 
Message output destination

Display
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Assumed Causes

The extension has already been specified for the language category specified.

 
Corrective Actions

Review file extensions.

 
STP-054 The development language of the file,[file name], cannot be identified.

When specifying assets by file, the extension of the measurement target source files cannot be identified.

 
Message output destination

Display

 
Assumed Causes

The extension of the file selected by the file specification does not correspond to any of the file extension registered as each language
type.

 
Corrective Actions

Specify the file that corresponds to one of the file extensions registered as each language type for the file selected by the file specification
for the measurement target.

 
STP-055 Multiple starts are prohibited.

The repetition starting cannot be done when there is an active process (It cannot executed by GUI and a batch).

 
Message output destination

Display

 
Assumed Causes

There is an active process.

 
Corrective Actions

Please use the Process that started previously.

 
STP-056 Use in the trial version is not possible.

This feature cannot be used in the trial version.

 
Message output destination

Display

 
Assumed Causes

This feature cannot be used in the trial version.

 
Corrective Actions

Please buy a formal version.

 
STP-057 Unable to find the file.

Unable to find the file.

 
Message output destination

Display

 
Assumed Causes

The File of the measurement object was deleted or moved.
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Corrective Actions

Please specify the File of the measurement object.

 
STP-058 Error in the number of files.

Error in the number of files.

 
Message output destination

Display

 
Assumed Causes

Measurement result File (*.stp) is damaged, and the content is unmatch.

 
Corrective Actions

Please read normal measurement result File (*.stp).

 
STP-059 Please specify a folder name.

Please specify a folder name.

 
Message output destination

Display

 
Assumed Causes

The folder name is not specified.

 
Corrective Actions

Please specify the folder name.

 
STP-060 Creation of header control failed.

Creation of header control failed.

 
Message output destination

Display

 
Assumed Causes

Creating header control is failed because of the environment or the data of unmatch.

 
Corrective Actions

Please reboot the re-measurement or reboot the Program.

 
STP-061 Creation of list control failed.

Creation of list control failed.

 
Message output destination

Display

 
Assumed Causes

Creating header control is failed because of the environment or the data of unmatch.

 
Corrective Actions

Please reboot the re-measurement or reboot the Program.
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STP-062 Failed to secure memory.

Failed to secure memory.

 
Message output destination

Display

 
Assumed Causes

Memory shortage.

 
Corrective Actions

Please clear the memory and measure again.

 
STP-063 Select one line to change.

Select one line to Change Extensions.

 
Message output destination

Display

 
Assumed Causes

[Change] was selected by the state for which the extension was not specified.

 
Corrective Actions

Please select the extension that changes.

 
STP-064 The same file name already exists.

The same file name already exists.

 
Message output destination

Display

 
Assumed Causes

The same name of file has already been registered.

 
Corrective Actions

Please select other Files.

 
STP-065 The contents will be erased and extensions initialized. Are you sure?

Information on the changed extension is returned to the state at the installation.

 
Message output destination

Display

 
Assumed Causes

[Initialization] was selected in the [Common - Extension] options dialog box.

 
Corrective Actions

Please execute the as needed after often confirming the initialization of the extension with the manual.

 
STP-066 Please specify the language type.

Please specify the language type.
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Message output destination

Display

 
Assumed Causes

When the extension is changed, the language kind is not specified.

 
Corrective Actions

Please specify the language kind.

 
STP-067 The size of measurement target file ,[file name], exceeds the limit.

It cannot measure because the size of the measurement target file exceeds the limit (4GB).

 
Message output destination

Display, Error File

 
Assumed Causes

The file with the size exceeding the limit (4GB) was specified as the measurement target file.

 
Corrective Actions

Check the size of specified measurement target file.
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Chapter 10 Samples
This chapter explains the samples provided with MF-STEPCOUNTER.

10.1 Sample Usage
When STEPCOUNTER is installed, the "SAMPLE\en" folder is created inside the installation folder and sample source files of various
language categories are stored.

[Samples for Step Measurement]

 
File Name Character Code Description

sample.c UNICODE 4.1.3 C/C++ Measurement Criteria

sample.cob UNICODE 4.1.2 COBOL Measurement Criteria

sample.java UNICODE 4.1.4 Java Measurement Criteria

Generation_sample.java UNICODE 4.1.5 Auto-generated Java Source Measurement Criteria

sample.idl UNICODE 4.1.6 IDL Measurement Criteria

sample.html UNICODE 4.1.7 HTML/JSP/JS/CSS Measurement Criteria

sample.vb, sample.cs,
sample.asp, sample.aspx

UNICODE 4.1.8 .NET (ASP/C#/VB)/HTML/JS/CSS Measurement
Criteria

sample.frm UNICODE 4.1.9 Visual Basic 6.0 Measurement Criteria

[Samples for Variation Measurement]

 
File Name Character Code Description

CompSamle_old.java,
CompSamle_new.java

UNICODE 4.2 Variation Measurement Criteria

These source files correspond to the examples given to explain measurement criteria.

 
To Measure Steps

1. Select the [New Measurement] command from the [File] menu.

2. In the New Measurement 1/2 Dialog Box, select [Steps] under [Measurement Type]. Select the desired language category for
measurement under [Language Category], [File] under [Target Resource Specification Method], and [UNICODE] under [Character
Code], and click the [Next] button.

3. In the New Measurement 2/2 Dialog Box, specify the measurement target source file or the folder in which the source file is located.

4. Click the [Finish] button to start measurement, and then the measurement results are displayed on screen.

 
To Measure Variation

1. Select the [New Measurement] command from the [File] menu.

2. In the New Measurement 1/2 Dialog Box, select [Variations] under [Measurement Type]. Select the desired language category for
measurement under [Language Category], [File] under [Target Resource Specification Method], and [UNICODE] under [Character
Code], and click the [Next] button.

3. In the New Measurement 2/2 Dialog Box, specify the old and new measurement target source files.

4. Click the [Finish] button to start measurement, and then the measurement results are displayed on screen.

 
To Change the Display Format (Step Measurement Only)

1. Select the [Step Measurement - Display] options configuration command from the [Options] menu.
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2. In the [Step Measurement - Display] Options Dialog Box, select [Form] or [List view] under [Display Initial Dialog].

3. If list view mode is selected, the items to be initially displayed can be selected in this dialog.

4. If form mode is selected, select the [Form] tab in the step measurement options dialog box to open the [Step Measurement - Form]
Options Dialog Box and select the information to be displayed.

5. Select the [Measure Changed] command from the [Measure] menu to update the display format without performing remeasurement.

6. From the [Display] menu, it is possible to select whether to display or hide display items. For details, refer to 6.1.3 [Display] Menu.

 
To Print Measurement Results (Step Measurement Only)

1. To print measurement results, display the results in form mode. In list view mode, the results cannot be printed (To print, save the
results as a CSV file as described later, and print it using an application such as spreadsheet software).

2. Select the [Print] command from the [File] menu.

3. In the Print Dialog Box, set the necessary items and click the [OK] button.

4. The measurement results are sent to the printer.

5. For details, refer to "Printing Measurement Results".

 
To Save Measurement Results as a CSV File

1. Select the [Save As CSV File] command from the [File] menu.

2. In the [Save As CSV File] dialog box, specify the CSV file name and click the [Save] button.

3. A CSV file with the specified name is created.

  When the measurement results are displayed in list view mode, individual lines can be selected to output only the relevant information.

1. Select the measurement results to be output to a CSV file from the list view (multiple selections are possible).

2. Select the [Save Selected Range As CSV File] command from the [File] menu.

3. In the [Save As CSV File] dialog box, specify the CSV file name and click the [Save] button.

When saving a CSV file, the saved format varies depending on how the measurement results are displayed. Refer to Form CSV File or List
View CSV File.

 
To Save Measurement Results

1. Select the [Save As] command from the [File] menu.

2. In the [Save Measurement Results File] dialog box, specify the measurement results file name and click the [Save] button.

3. A measurement results file with the specified name is created.

When assets were changed or measurement results were updated, select the [Save] command from the [File] menu.

 
To Read the Measurement Results File

1. Select the [Read] command from the [File] menu.

2. In the [Read Measurement Results File] dialog box, select the measurement results file and click the [Open] button.

3. The measurement results saved in the measurement results file are displayed on screen.

When COPY phrase files or include files are used in the measurement target source, set [Step Measurement - Search Path] options before
measurement.
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